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FOREWORD

Introduction

FURUNO Electric Company thanks you for considering and purchas-
ing the FELCOM 12 Inmarsat-C Mobile Earth Station. We are confi-
dent you will discover why the FURUNO name has become synony-
mous with quality and reliability.

Mainly consisting of an antenna unit, a communication unit and ter-
minal unit, the FELCOM 12 provides the full range of distress and
general communication services for mobile and fixed terrestrial sub-
scribers in the Inmarsat-C communication network. Its compact size
permits installation where space is limited.

FURUNO designs and manufactures this equipment with much at-
tention to operation and maintenance simplicity. However, please read
and follow the recommended procedures for operation and mainte-
nance to get the most out of the equipment.

This manual provides a brief introduction to the Inmarsat-C system
(pages 5 thru 10). For more detailed information, however, please
refer to “Inmarsat-C Maritime User’s Manual” published by Inmarsat.
(It is free of charge.) Below are contact points for Inmarsat.

Inmarsat-C Maritime Customer Relations Officer
Maritime Services Operations Department
International Maritime Satellite Organization (Inmarsat)

Address: 99 City Road, London EC1Y 1AX, UK

Telephone: +44 71 728 1000 (Switchboard)
Fax: +44 71 728 1192
Telex: 297201 Inmarsat G
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Features

E-mail facility
To transmit E-mail, register with the LES provider. E-mail
charges are calculated separately.

Built in Enhanced Group Call (EGC) receiver permits operation as
EGC-only receiver.

Communication unit accepts a wide variety of peripheral equip-
ment, Distress Message Controller (DMC), personal computer and
remote panel.

Connection of 2nd Data Terminating Equipment (DTE) for opera-
tion from remote location such as the bridge

Store-and-forward telex communication (public telex network)

Data reporting and Polling

Internal GPS receiver (option) in the communication unit provides
GPS-generated position.

Self test programs for maintenance

Terminal unit provides floppy disk drive for unlimited storage of
received and transmitted messages on floppy disks.

Menu driven operation
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About This Manual

A word about the organization of this manual: It is laid out in a user-
friendly manner as possible. We realize a machine like this with its
many, many functions can be a little intimidating to even the experi-
enced MES operator. This is why we have arranged this manual in a
series of sections that start at a basic level and proceed forward in
complexity in a logical manner.

The best way to acquaint yourself with the many facilities this equip-
ment has to offer is to turn it on and try keying in the examples pro-
vided in each of the sections. In hardly no time at all you’ll be enjoying
the benefits of the Inmarsat-C system.

Inmarsat-C System This chapter explains the Inmarsat-C sys-
tem.

Operational Overview This chapter introduces basic operations.

System Initialization Read this chapter to learn how to initialize
the FELCOM 12.

File Operations You will learn how to use the text editor in
this chapter, to prepare, edit and save mes-
sages.

Inmarsat-C Read this chapter to learn how to transmit
Communications and receive in the Inmarsat-C system.

Data Reporting and Polling
This chapter explains data reporting set-
ting and polling reception.

Distress Alert This chapter tells you how to prepare and
transmit the distress alert, and conduct dis-
tress communications.

Other Functions This chapter describes how to abort op-
eration, scan NCS, and select various chan-
nels.

Maintenance The maintenance chapter presents infor-
mation for keeping the FELCOM 12 in top
operating condition.

Appendix The Appendix presents international telex
country codes, international telex abbre-
viations, glossary of acronyms, error mes-
sages and alerts, and international telegra-
phy alphabet.
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FELCOM 12 System Configuration

Figure 1 FELCOM 12 system configuration
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INMARSAT-C SYSTEM

This chapter provides an overview of the Inmarsat-C satellite com-
munication system.

Introduction

The Inmarsat-C system provides worldwide telex and data transmis-
sion and reception of written information to owners of an Inmarsat-C
transceiver or a terrestrial telex network via satellite.

Communication mode is store-and-forward telex, which means all
information sent are first stored at a LES and then delivered to desig-
nated party.

An EGC (Enhanced Group Call) receiver is built in the FELCOM 12
to receive the following types of messages, broadcast from a LES:

SafetyNETTM-governments and maritime authorities can use this
service to distribute maritime safety information to ships within
selected areas.

FleetNETTM-commercial subscription organizations or shipping
companies can use this service to transmit trade information (for
example, company news or market prices) simultaneously to a se-
lected group of ships, to provide up-to-the-minute information.

FELCOM 12 allows you to make distress calls which are given im-
mediate priority over all other calls, and are automatically routed to a
land-based Rescue Co-ordination Centre (RCC).

Besides its primary application of ship-shore, shore-ship or ship-ship
communications, the Inmarsat-C service has also proved beneficial
to trucking firms who have found it indispensable for communicat-
ing with their vehicles. In this manual, however, we will concentrate
on ship applications, the main application.
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Inmarsat System Configuration

Figure 2 Inmarsat-C satellite communication system
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The Inmarsat-C system consists of the Operation Control Center
(OCC), Satellite Control Centers (SCC), Network Coordination Sta-
tions (NCS), Land Earth Stations (LES) and Mobile Earth Stations
(MES). The OCC, located at Inmarsat’s London headquarters, coor-
dinates a wide range of activities in the Inmarsat system, including
commissioning of mobile earth stations.

The Inmarsat-C system divides the world into four regions and each
region is covered by its own satellite.

Table 1 Inmarsat system satellites

Region Satellite Satellite Position

  AOR-West   Inmarsat-2, F4 54.0°W

  AOR-East   Inmarsat-2, F2 15.5°W

  IOR   Inmarsat-2, F1 64.5°E

  POR   Inmarsat-2, F3 178.0°E

In each region there is one NCS and several LESs. The NCS keeps
track of all Inmarsat-C transceivers in its region and broadcasts in-
formation such as navigational warnings, weather reports and news.
The LES provides the link between the MES and the terrestrial tele-
communications networks via satellite.
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Communications Network

Figure 4 shows the Inmarsat-C communications network.

Figure 4 Inmarsat-C communications network

NCS common channel The NCS has two major functions:
1) Transmitting information on a com-

mon channel.

2) Transmitting EGC messages to MESs.

NCS/LES signalling link This is the link between NCS and all
LESs in its region. All EGC messages
pass through this link.

LES TDM channel This channel carries the circuit control
signal for MES and transmits messages
from LES to MES.

MES message channel This channel carries messages from
MES to LES.

MES signaling channel This channel transmits requests, distress
alerts, data reports, etc. In addition, it
carries login and logout from MES to
NCS.

NCS/NCS signaling link This is the link between NCSs. It ex-
changes data between MESs operating
in different ocean regions.



 10

MES interface The MES consists of the Data Circuit
Terminating Equipment (DCE) and the
Data Terminal Equipment (DTE). The
DCE consists of the antenna unit and
the communication unit. And the DTE
consists of the terminal unit (or a PC),
keyboard and printer.

Terrestrial network The major functions of the LESs are:
interface

1) Telex store-and-forward conversion
2) Handling EGC messages
3) Handling distress alerts
4) Data Reporting and Polling

Types of MES

There are three types of MES: class 1, class 2 and class 3. The
FELCOM 12 is a class 2 MES.

Class 1 1) Transmits messages to LES
2) Receives messages from LES

Class 2 1) The functions of class 1 plus opera-
tion as an EGC receiver when not
transmitting or receiving.

2) EGC-only receiver

Class 3 The function of class 1 plus simulta-
neous operation as a EGC-only receiver.
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Peripheral Equipment

The following equipment can be additionally connected to the
FELCOM 12.

Distress/Urgent Receiving Unit (IC-303)

The IC-303 releases an audible alarm and blinks the lamp when dis-
tress message is received. (Refer to page 4-26 for further details.)
When an EGC distress or urgent message is received, with an aural
alarm and blinking lamp.

Distress Alert Unit (IC-302)

The IC-302 enables transmission of the distress alert from a remote
location; for example, ship’s bridge. (Refer to page 6-3 for more de-
tails.)

Distress Message Controller (DMC-5:Option)

The DMC provides for transmission and monitoring of the distress
alert. For further details, refer to the operator’s manual of the DMC-
5.

Figure 5 Distress Message Controller system



1-1

OPERATIONAL OVERVIEW

This chapter provides an overview of the FELCOM 12 system.

The Communication Unit

The communication unit is the heart of the FELCOM 12 system, trans-
mitting and receiving messages and alerting you to equipment fault.

On its front panel you should see the POWER switch and POWER
lamp. Normally, the power is left on while underway.

Figure 1-1 Communication unit IC-212

Self test

When the communication unit is turned on it conducts a series of
self-tests to check itself for proper operation.

When the audible alarm sounds

The audible alarm sounds in the following circumstances:

1) EGC distress or urgent message is received. (To silence the alarm,
press [ESC] followed by [F10].)

2) During the interval between the transmission of the distress alert
(by own vessel) and the receiving of the distress acknowledge sig-
nal from LES. (The alarm automatically stops when your ship
recives the distress acknowledge signal.)

3) The system status monitor detects equipment fault. (To silence the
alarm, press any key.)

The audible alarm sounds and the terminal unit displays which alarm
is sounding.
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The Terminal Unit

The DTE may consist of IB-581 or IBM compatible pc. All opera-
tions are carried out from the terminal unit, through an easy-to-un-
derstand menu system. For personal computer connection a system
disk (supplied) is required to boot up the computer. Opetarion by a
computer is the same as with the terminal unit except when turning
on the power.

Figure 1-2 Terminal unit IB-581

To turn on/off the unit, press the POWER switch.

Controls for adjustment of screen brilliance and contrast are to the
right of the POWER switch.

Floppy disk drive

The terminal unit provides a floppy disk drive for storing transmitted
and received messages on floppy disks.

Floppy disk

The floppy disk used with the system is a standard 3.5” floppy disk.
Always leave a floppy disk inserted to save incoming messages.

Terminal unit cannot print file from a floppy disk when there is not
enough space remaining on the disk. In this case, replace disk with
formatted disk.
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Printer PP-510 (optional supply)

The printer prints transmitted and received messages. The POWER
switch is on the right side of the unit. A lamp on the switch lights
when the power is on. If the paper is set correctly the ON LINE lamp
also lights. When both these lamps are lit the printer is ready to print
information received from the terminal unit. For further details, refer
to the operator's manual of the PP-510.

Figure 1-3 Printer PP-510
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Keyboard

The FELCOM 12 is almost 100% keyboard controlled. Operation is
simplified by the use of menus which you access by pressing func-
tion keys, numbered F1-F10 at the top of the keyboard. Figure 1-4
shows keyboard layout.

Figure 1-4 Keyboard

Key description

Esc Cancels key input and returns to previous
display screen.

F1-F10 These are the function keys. They select
menus.

Backspace Deletes the character to the left of the cur-
sor.

Insert Works the same as PASTE function. See
page 3-5.

Delete Deletes the character on the cursor.

Home Moves the cursor to the top of a message
being edited.

End Moves the cursor to the bottom of a mes-
sage being edited.

PgUp Goes to the previous page of the edit screen.

PgDn Goes to the next page of the edit screen.

[ ], [ ], [ ], [ ] Control the cursor.

Enter Registers key input.
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Shift Selects upper or lower case letters. Press and
hold down the key to get upper case letters.
Note that only upper case letters are used in
telex.

Alt Executes the shortcut key operation when
combined with an alphabet key.

Space Bar Inserts a space. In addition, it displays file
list, partial view of a file, etc. depending on
menu.

Caps Lock Turns upper case letter input on or off. CAPS
appears on the display when the keyboard
is set for upper case letter input.

Tab Inserts horizontal tab characters. The num-
ber of tab characters the key can insert per
line of text can be programmed for two, four
or eight tabs.

Ctrl Works in combination with alphabet keys as
follows:

Table 1-1 Ctrl key shortcuts

  Ctrl+[M]   Same as Enter.

  Ctrl+[H]   Same as Back Space.

  Ctrl+[I]   Same as Tab.

FN                        Combined with an arrow Key, it  scrolls
                                          screen( , ),or shifts cursor ( , ).

Num Lock Turns numeric input on or off. Note that you
cannot enter alphabet when the Num LED
is its.

Note: In telex, lower case, #, &, *, $ or % are not used. A full list of
characters usable in telex appears on page A-11 in the Appen-
dix.
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Shortcut key operation

The FELCOM 12 provides the keyboard shortcuts shown below for
commonly used functions.

Table 1-2 Shortcut keys

Function Menus

The function menus, which you access by pressing the function keys
(F1-F10) at the top of the keyboard, control most operations of this
unit.

Figure 1-5 Keyboard, showing function menu keys
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Selecting menu, menu options

Press appropriate function key to select a menu. For example, press
[F1] to select the File menu.

Figure 1-6 File menu

You may select menu options with the arrow keys (pressing [Enter]
after making selection) or appropriate numeric key. As the cursor
moves down through a menu, when usings the arrow keys, each menu
option, initially shown as white on black, reverses to black on white.
This highlighting indicates the item is available for selection. In Fig-
ure 1-6, for example, “New” is available for selection.

Function menu description

Table 1-3 Function menu description

 Menu  Description

 File  Processes files.

 Edit  Provides text editing facilities.

 Transmit  Transmits messages.

 EGC  Sets up EGC message facilities.

 Reports  Sets up data reporting function.

 Logs  Displays send and receive message logs.

 Options  Login, logout, testing facilities.

 Setup  Sets up the system.

 Position Enters your ship's position.

 Stop Alarm  Silences buzzer.
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Sample menu operation

For example, you want to display a transmitted message. All opera-
tions begin from the standby display.

Figure 1-7 Standby display

Press [F6] to display the Logs menu.

Figure 1-8 Logs menu

Press [1] to display the send message log.

Figure 1-9 Send message log

Select the message you want to display by pressing [ ] or [ ] fol-
lowed by [Enter].
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Display Indications

The display is divided in three sections:

1) The menu area
2) The working area
3) The operating status area

Figure 1-10 Location of display indications

Below are indications and their meanings.

(1) Distress alert information

No display (no distress alert)

Distress Alert Activated

Distress Alert Test Activated

Distress Alert Acknowledge Received

Distress Message Call Activated

Distress Message Call Acknowledged

(2) Communication network mode

No display Normal operation

Restoration Mode Problem at NCS.
(blinking)

Restoration Mode Previously designated LES is trans-
(reverse indication) mitting the NCS common channel

signal.
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(3) Communication unit status

Idle Idle (awaiting receiving, awaiting trans-
mitting)

Idle (pending) Awaiting reply from LES

Sending During message transmission

Receiving During receiving

Login Logging in with NCS

Logout Logging out with NCS

Distress Alert When own vessel is transmitting the
distress alert

Data Report During transmission of data report

Testing PV testing

Test Setup Requesting PV testing

Scanning NCS scanning

EGC RECEIVER EGC-only receiver operation
(reverse indication)

Delivery Status Req. When transmitting delivery status re-
quest

Forced Clearing When stopping receiving, transmitting,
or scanning

(4) Communication unit remarks and DCE
version number

This area provides remarks about communication unit status.

(5) Frame synchronization

Blank When changing channel, or during
transmission

SYNC (NCS) Synchronizing with NCS

SYNC (LES) Synchronizing with LES

UNSYNC Out of synchronization

Retuning Synchronizing with NCS or LES

(6) Ocean region receiving

No display Out of synch with satellite

AOR-W Atlantic Ocean Region-West

AOR-E Atlantic Ocean Region-East

IOR Indian Ocean Region

POR Pacific Ocean Region



1-11

(7) Logging status

LOGOUT Logged out with ocean region

LOGIN Logged in with ocean region

LOGIN (blinking) Logging in with ocean region

(8) Other information

No display No receive message in memory, or
printer is operating.

REC. MESSAGE EXISTS Displayed when a routine message has
(blinking) not been printed, or a confidential mes-

sage is received.

DATA REPORT When data reporting is activated.
(Reverse indication)

(9) Date and time display

The date (set at system setting) and time (set by satellite) appear.
Time is updated every minute (with navigator connection).

(10) Ship’s position

Ship’s position (automatic or manual input) appears here.

Error Messages and Alerts

The terminal unit displays error messages and alerts to call your at-
tention to misoperation, failed operation and system error. A list of
error messages and alerts appears on pages A-12 through A-14 in the
Appendix. To erase an error or an alert, press [Esc].

Figure 1-11 Location of error messages and alerts
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Silencing the Audible Alarm

Some error messages and alerts are accompanied by the audible alarm.
This alarm can be silenced, in most instances, by pressing any key. If
the alarm cannot be silenced in that manner, go to the Setup menu to
silence it. Note that the distress alert alarm transmitted by own ship
cannot be silenced by either method; it automatically stops when you
receive the distress acknowledge signal from LES.

Silencing the alarm by the Setup menu

1. Press [F8] to display the Setup menu.

Figure 1-12 Setup menu

2. Press [6] to display the Auto Mode Setup menu.

3. Press [ ] key to go to the Receive Alarm line.

4. Press [Enter] to open the selection window.

Figure 1-13 Auto mode setup menu
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5. Press [ ] to select OFF..

Note: To silence the audible alarm given to an EGC distress or
urgent message from Distress Alert Unit (IC-302), follow
the above procedure. DO NOT press the DISTRESS button
on the IC-302 to silence the alarm; you will transmit own
ship’s distress alert.

6. Press [Enter] to close the selection window.

7. Press [Esc] twice.

Using a Personal Computer as a Terminal Unit

PC requirements

Applicable PC: Toshiba T-2110 or IBM-AT compatible

Memory required: 640K bytes

Graphics: Any one of CGA/EGA/VGA

Disk Drive: One 2HD

Operating System: MS-DOS Version 3.0 or later

Installing the program

Make the directory "FELCOM12" on the hard disk (drive C) and
install the program there as follows;

1. Go to the MS-DOS prompt.

2. Insert the program disk (supplied) in drive A.

3. Type "A:" and press [Enter].

4. Type "PCRINST" in case of main DTE and press [Enter]. The
directory MAIL (default directory), where receive messages are
automatically saved, is automatically made. To save receive
messages to a different directory, use the RD command to
delete the MAIL directory. (See "Setting Directories" on page
2-27.)
Type "PCRINST2" in case of 2nd DTE press  [Enter].

5. To install Russian software, type "PCRINST" and press [Enter].
(Russian and English may be switched by pressing left [SHIFT]
with lift [CTRL] and left [ALT] .)

6. Turn off the power.

7. Turn on the power.

8. Confirm that the software starts up properly.

Note: You need 128KB (or more) of extended memory in RAM.
De-designate extended memory filer (such as HIMEM.SYS) in
config.sys file, when extended memory in used.
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Contents of program disk

READ.ME: Instructions for installation of software

IBINST.BAT: English software for IB-581

IBRINST.BAT: Russian software for IB-581

PCINST.BAT: English software for PC

PCRINST.BAT: Russian software for PC

INSTALL.BAT: Program start up

FELCOM12.EXE: Terminal software

ENGLISH.DAT: English text definition file

RUSSIAN.DAT: Russian text definition file

ENH_FONT.EXE: Russian driver

DTE.DAT: Terminal software definition file (for PC)

DTE.B: Terminal software definition file (for IB-581)

LES.DAT: LES list

FORMAT.COM: Format disk
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SYSTEM INITIALIZATION

This chapter provides the information necessary for initializing the
FELCOM 12. Once the FELCOM 12 is initialized you need do no
more than press a few keys to get fully automatic transmission and
reception.

Inmarsat assigns each MES an Inmarsat Mobile Number (IMN). The
IMN has already been entered into the FELCOM 12.

System Settings

Two sets of DTEs installed

The communication unit provides two sets of connectors (DTE1, main;
DTE2, 2nd) for connection of two DTEs. It is preset at the factory for
connection with one DTE (main DTE). Main DTE is available to set
the menu.

1. Press [F8] to select the Setup menu.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Current State: IDLE

DCE Ver **

SYNC ( NCS )
NCS: IOR        LOGOUT

97-08-04  01:50 (UTC)

Setup

1. Distress Alert Setup
2. System Setup
3. Editor Setup
4. Terminal Setup
5. EGC Setup
6. Auto Mode Setup
7. E-Mail Setup
8. Directories
9. Configuration

Figure 2-1 Setup menu

Menu Items which cannot be set on 2nd DTE (Sub DTE )are shown
in gray.
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System setup

The System Setup menu provides for input of date, time, operating
mode, and port function.

1. Press [F8] to select the Setup menu.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Setup

1. Distress Alert Setup
2. System Setup
3. Editor Setup
4. Terminal Setup
5. EGC Setup
6. Auto Mode Setup
7. E-Mail Setup
8. Directories
9. Configuration

Figure 2-4 Setup menu

2. Press [2] to display the System Setup screen.

Note:  If the communication unit is off or its interconnection cable
has loosened or is damaged, “No response from communi-
cation unit.” appears.

Setup

9. Configuration

System Setup

01:53  97-08-04 (YY-MM-DD)
IOR
INMARSAT-C
OFF
DTE1
DTE1
DTE1

System Date & Time
Preferred NCS
MES Operation Mode
Nav Port
Active Port
Message Output Port
EGC Output Port

Figure 2-5 System setup menu

3. Press [Enter] to open the date window.

Setup

9. Configuration

System Setup

01:53  97-08-04 (YY-DD)

INMARSAT-C
OFF
ALL
DTE1
DTE1

01:53  97-08-04System Date & Time
Preferred NCS
MES Operation Mode
Nav Port
Active Port
Message Output Port
EGC Output Port

Figure 2-6 System setup menu, system date & time

4. Enter the date.

5. Press [Enter] to close the window.

6. Press [

/

] to advance the cursor to the Preferred NCS line.

Note:   Date cannot be entered in the FFA version.
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7. Press [Enter] to open the selection window.

Setup

9. Configuration

System Setup

01:53  97-08-04 (YY-MM-DD)
IOR
INMARSAT-C
OFF
DTE1
DTE1

Auto
AOR (WEST)
AOR (EAST)
POR
IOR

System Date & Time
Preferred NCS
MES Operation Mode
Nav Port
Active Port
Message Output Port
EGC Output Port

Figure 2-7 System setup menu, preferred NCS

8. Select appropriate NCS (Auto, AOR-West, AOR-East, POR or
IOR) by arrow keys. The FELCOM 12 will search for that NCS
signal each time it is turned on. The Auto setting searches all NCS
signals to find the most suitable NCS; thus, scanning can take
quite some time. (For reference, the coverage range of each satel-
lite is shown in the figure on page 8.)
If you want to change the NCS channel temporarily, refer to “Se-
lecting NCS channel” on page 7-4.

9. Press [Enter] to close the selection window.

10. Press [

/

] to advance the cursor to the MES Operation Mode line.

11. Press [Enter] to open the selection window.

Setup

9. Configuration

System Setup

01:53  97-08-04 (YY-MM-DD)
IOR
INMARSAT-C
OFF

DTE1
DTE1

INMARSAT-C
EGC

System Date & Time
Preferred NCS
MES Operation Mode
Nav Port
Active Port
Message Output Port
EGC Output Port

Figure 2-8 System setup menu, MES operation mode

12. Select operating mode, either Inmarsat C or EGC. The Inmarsat
C setting provides telex communications and operates as an EGC
receiver when not transmitting or receiving. The EGC setting en-
ables EGC-only receiver operation. In this case EGC RECEIVER
appears in reverse indication at the bottom of the screen.

13. Press [Enter] to close the selection window.

14. Press [

/

] to advance the cursor to the Nav Port line.

Note:  The MES Operation Mode in the FFA version cannot
           be set  to other than“Inmarsat C.”
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15. Press [Enter] to open the selection window.

Setup

9. Configuration

System Setup

01:53  97-08-04 (YY-MM-DD)
IOR
INMARSAT-C
DTE1OFF
DTE1
DTE1

OFF
EXT
INT

System Date & Time
Preferred NCS
MES Operation Mode
Nav Port
Active Port
Message Output Port
EGC Output Port

Figure 2-9 System setup menu, nav port

16. Select the navigation device which is interfaced to the
FELCOM 12.

OFF: No connection

EXT: Select this setting when external navigation device is
connected. The FELCOM 12 automatically selects ship’s
position information in the order of GPS, LC, and
DECCA.

INT: Internal GPS board provides position data.

Note:  The Nav Port setting in the FFA version cannot be set to
other “INT.”

Note:  If there is no navigation equipment connection (Nav Port
setting is “OFF”), you should input dead reckoning posi-
tion in the Position menu. Refer to page 2-26.

17. Press [Enter] to close the selection window.

18. Press [

/

] to advance the cursor to the Active Port line.

19. Press [Enter] to open the selection window.

Setup

9. Configuration

System Setup

01:53  97-08-04 (YY-MM-DD)
IOR
INMARSAT-C
OFF

DTE1
DTE1

DTE1
ALL

System Date & Time
Preferred NCS
MES Operation Mode
Nav Port
Active Port
Message Output Port
EGC Output Port

Figure 2-10 System setup menu, active port

20. Select active port (DTE); “DTE1” or “ALL”.

DTE1: Only DTE1 is active.
ALL: DTE1, DTE2 and PC/DATA are active.

21. Press [Enter] to close the selection window.

22. Press [

/

] to send the cursor to the Message Output Port line.
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23. Press [Enter] to open the selection window.

Setup

9. Configuration

System Setup

01:53  97-08-04 (YY-MM-DD)
IOR
INMARSAT-C
DTE1
OFF
DTE1

System Date & Time
Preferred NCS
MES Operation Mode
Active Port
Nav Port
Message Output Port
EGC Output Port

DTE1
DTE2
PC/DATA
AUTO

Figure 2-11 System setup menu, message output port

24. Select the DTE where you want to store receive messages.

DTE1: All receive messages are routed to the main DTE
(connected to DTE1 on the communication unit)
regardless of sub address.

DTE2: All receive messages are routed to the 2nd DTE
(connected to DTE2 on the communication unit)
regardless of sub address.

PC/DATA: All receive messages are routed to the PC/DATA
(connected to PC/DATA on the communication unit)
regardless of sub address (not used).

AUTO: Select to route messages with sub address 000 to
the main DTE, and messages with the sub address
of the 2nd DTE to the 2nd DTE. All other mes-
sages are routed to the main DTE.

Note: Do not select DTE2 or Auto when there is no DTE con-
nected to the DTE2 port; messages cannot be read from
the communications unit.

25. Press [Enter] to close the selection window.

26. Press [

/

] to advance the cursor to the EGC Output Port line.

27. Press [Enter] to open the selection window.

                  

Setup

9. Configuration

System Setup

01:53  97-08-04 (YY-MM-DD)
IOR
INMARSAT-C
OFF
DTE1
DTE1

System Date & Time
Preferred NCS
MES Operation Mode
Nav Port
Active Port
Message Output Port
EGC Output Port

DTE1
DTE1+DTE2

Figure 2-12 System setup menu, EGC output port

28. Select the DTE where you want to store receive EGC messages;
DTE1, DTE2 or PC/DATA.

29. Press [Enter] to close the selection window.
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30. Press [Esc] to open the update window.

Setup

9. Configuration

System Setup

System Date & Time
Preferred NCS
MES Operation Mode
Nav Port
Active Port
Message Output Port
EGC Output Port

01:53  97-08-04 (YY-MM-DD)
IOR
INMARSAT-C
OFF
DTE1
DTE1
DTE1

Update

Yes No

Figure 2-13 System setup menu, update

31. Press [Enter] to select “Yes”.

32. Press [Esc] to register all system setup settings and return to the
standby display.

Terminal Setup

Terminal Setup menu provide for date display format,screen saver
and display mode.

1.   Press [F8]  to select the Setup menu.

2.   Press [4]  to display the Terminal Setup screen.

 

Terminal Setup

Date Disp. Form
Screen Saver
Display Mode

YY-MM-DD
ON
Normal Mode

                        Figure 2-14  Terminal Set up menu.

3.   Press [Enter] to open the selection window.

4.  Select date display format “YY-MM-DD(year-month-day)”,
“ MMM-DD-YY(month-day-year )” or “ DD-MMM-YY(day -
month -year)”.

5.   Press [Enter] to close the selection window.

6.   Press [

/

] to advance the cursor to the Screen Saver line.

7.   Press [Enter] to open the selection window.

8.   Select “ON” or “OFF”.

9.   Press [Enter] to close the selection window.

10. Press [

/

] to advance the cursor to the Display Mode line.

11. Press [Enter] to open the selection window.
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12.  Select “Normal Mode” or “Reverse Mode”.
        Normal Mode displays black characters on white
        backgrund.
        Reverse Mode displays white characters on black
        backgrund.

13. Press [Enter]  to close the selection window.

14  Press [Esc]  to return to the standby display.

Login and Logout

Each time the DTE and communication unit are turned on register
your vessel with the Inmarsat C system, to enable communications
between your vessel and LES. This is called login. The first time you
login you must do it manually; thereafter the NCS does it for you
automatically, even when you move to another ocean region.

Note that the distress alert can be transmitted and EGC messages
received regardless of whether you are logged in or not.

If you will not be using the FELCOM 12 for a prolonged period
you should logout from the Inmarsat C system, before turning
off the power to the communication unit. The Inmarsat C system
will then register you as inactive, notifying anyone trying to call you
that you are currently unavailable. If you do not log out before turn-
ing off the power, the LES may attempt to send a message to you. It
may charge your correspondent, even if you never receive the
message.

Note:  The communication unit should be idle (“Current State: IDLE”
appears at the bottom of the screen) to login and logout.

Note:  When the FFA version  is active, vessel is automatically logged
in when the power is turned on.
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Login

1. Confirm that “SYNC (NCS)” appears at the bottom of the screen.

2. Press [F7] to display the Options menu.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Current State: IDLE

DCE Ver **

SYNC ( NCS )
NCS: IOR        LOGOUT

97-08-04  02:01 (UTC)

1. Login
2. Logout
3. Abort
4. Select NCS
5. Ocean Region
6. Test

Options

Figure 2-15 Options menu

3. Press [1] to display the Login screen.

Options
Login

Start

NoYes

Figure 2-16 Login screen

Note:  The communication unit must be idle to login. When it is
not idle, “Communication Unit is not IDLE now. Cannot
start login.” appears. Press any key to return to the standby
display. Wait until the communication unit becomes idle.

4. Press [Enter] to start login.
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5. LOGIN begins and the screen should now look something like
Figure 2-17. The indication LOGIN appears in blinking reverse
video.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Current State: LOGIN
CALLING
DCE Ver **

97-08-04  02:02 (UTC)
LAT:
LON:

LOGIN replaces IDLE.
Blinking during login

SYNC ( NCS )
NCS: IOR        LOGIN

Options
Login

Starting Login Process.
Press any key to escape.

Figure 2-17 Appearance of display screen during login

6. When login is completed, “Successful login” appears. The com-
munication unit goes into Idle state, LOGIN stops blinking and
the ocean region you logged in with appears on the screen.

7. Press any key to return to the standby display.

Logout

1. Press [F7] to display the Options menu.

2. Press [2] to display the logout screen.

Note:  The communication unit must be idle to logout. When it is
not idle, “Communication Unit is not IDLE now. Cannot
start logout.” appears. Press any key to return to the standby
display. Wait until the communication unit becomes idle.
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File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Current State: IDLE
Successful Login.
DCE Ver **

SYNC ( NCS )
NCS: IOR        LOGIN

97-08-04  02:04 (UTC)
LAT:
LON:

Options
Logout

Start

Yes No

Figure 2-18 Options menu, logout screen

3. Press [Enter] to start logout. Logout begins and the screen now
looks something like Figure 2-19.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Current State: LOGOUT
CALLING

DCE Ver **

97-08-04  02:02 (UTC)
LAT:
LON:

SYNC ( NCS )
NCS: IOR        LOGOUT

Options
Logout

Starting Logout Process.
Press any key to escape.

Figure 2-19 Appearance of display screen during logout

4. When logout is completed, “Successful logout” appears. The Cur-
rent State returns to IDLE.

5. Now you can turn off the power of the FELCOM 12.

Note:  In the FFA version, the display shows the message“INF:
Logout  request accepted. plase wait.”
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EGC Settings

What is the EGC (Enhanced Group Call) service?

The EGC service enables EGC information providers to send
SafetyNETTM or FleetNETTM messages via a LES to select groups of
ships, or to all ships within a defined geographical area.

To send an EGC message, the information provider prepares the mes-
sage, and then accesses the Country of international telex network to
send the message to the LES. The LES processes and forwards it to
the NCS for the ocean region designated by the provider. Then, NCS
broadcasts the message throughout the ocean region.

Although all MESs can receive the EGC message, the message is
accepted only by those receivers that have been pre-programmed for
the area or group conditions contained in the message. All other EGC
receivers reject the message.

Two EGC services are available:

1) SafetyNETTM

This provides a means for information providers to distribute Mari-
time Safety Information (MSI) from shore-to-ship. Authorized in-
formation providers include:

a. Hydrographic Offices, for navigational warnings

b. National Weather Services, for meteorological warnings and
forecasts

c. Rescue Co-ordination Center, for shore-to-ship distress alerts
and other urgent information

d. International Ice Patrol, for North Atlantic ice hazards

2) FleetNETTM

This service allows authorized information providers such as com-
mercial subscription services, shipping companies and govern-
ments, which have registered with a LES that supports
FleetNETTM, to broadcast messages to selected group of MESs.
Typical applications of FleetNETTM are:

a. Fleet or company broadcasts

b. News broadcasts

c. Commercial weather services

d. Market quotations

e. Government broadcasts to all vessels on a country’s registra-
tion
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EGC setup

The FELCOM 12 receives EGC messages directed to its present po-
sition and Navarea without further programming. The EGC Setup
screen lets you select additional areas for which you wish to receive
messages and also the Navtex station and type of message for Coastal
Warning (NAVTEX Re-broadcast).

1. Press [F8] to display the Setup menu.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup     Position    StopAlarm

Setup

1. Distress Alert Setup
2. System Setup
3. Editor Setup
4. Terminal Setup
5. EGC Setup
6. Auto Mode Setup
7. E-Mail Setup
8. Directories
9. Configuration

Figure 2-20 Setup menu

2. Press [5] to display the EGC Setup screen.

Setup

EGC Setup

Receive EGC Area
Additional Position

Navarea
Fixed Area
Waypoint (from NAV Equipment)

NAVTEX
Station Code
Type of Message (Can’t reject other report)

Ice reports
Meteo. forecasts
Pilot service
DECCA messages
LORAN messages

OFF
OFF
OFF
OFF
OFF

OMEGA messages
SATNAV messages
Other navaid msg
QRU (no message)

OFF
OFF
OFF
OFF

    :               :

OFF

Figure 2-21 EGC setup screen

The cursor is on the Additional Position line, where you can enter
L/L position of an ocean region you want to receive broadcasts
for.

3. Press [Enter] to open the additional position window.

4.  Enter positions as follows.

a) Enter latitude.

b) Enter [N] or [S].

c) Enter longitude.

d) Enter [E] or [W].
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5. Press [Enter] to close the position window.

6. Press [

/

] to send the cursor to the Navarea line.

7. Press [Enter] to open the Navarea window.

Setup

EGC Setup

Receive EGC Area
Additional Position

Navarea
Fixed Area
Waypoint (from NAV Equipment)

NAVTEX
Station Code
Type of Message (Can’t reject other report)

Ice reports
Meteo. forecasts
Pilot service
DECCA messages
LORAN messages

OFF
OFF
OFF
OFF
OFF

OMEGA messages
SATNAV messages
Other navaid msg
QRU (no message)

OFF
OFF
OFF
OFF

    :               :

OFF

Figure 2-22 EGC setup screen, Navarea window

8. Enter additional Navarea(s) (up to nine) for which you want to
receive broadcasts. Figure 2-23 shows the Navareas of the world.
Referring to the figure below for numeral and alphabet, enter ad-
ditional Navareas (up to nine) for which you want to receive broad-
casts.

Figure 2-23 Navareas

9. Press [Enter] to close the Navarea window.

10. Press [

/

] to send the cursor to Fixed Area.

11. This line is where you enter fixed areas (max. 3) for chart correc-
tion service. However, this service is not yet available; enter no
data.

12. Press [

/

] to send the cursor to the Waypoint line.
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13. Press [Enter] to open the Waypoint window.

Setup

EGC Setup

Receive EGC Area
Additional Position

Navarea
Fixed Area
Waypoint (from NAV Equipment)

NAVTEX
Station Code
Type of Message (Can’t reject other report)

Ice reports
Meteo. forecasts
Pilot service
DECCA messages
LORAN messages

OFF
OFF
OFF
OFF
OFF

OMEGA messages
SATNAV messages
Other navaid msg
QRU (no message)

OFF
OFF
OFF
OFF

    :               :

OFFON
OFF

Figure 2-24 EGC setup screen, waypoint

14. Select ON to receive broadcasts for the area of a destination
waypoint selected on the navigation device.

15. Press [Enter] to close the Waypoint window.

16. Press [
/

] to advance the cursor to the Station Code line.

17. Press [Enter] to open the Station Code window.

Setup

EGC Setup

Receive EGC Area
Additional Position

Navarea
Fixed Area
Waypoint (from NAV Equipment)

NAVTEX
Station Code
Type of Message (Can’t reject other report)

Ice reports
Meteo. forecasts
Pilot service
DECCA messages
LORAN messages

OFF
OFF
OFF
OFF
OFF

OMEGA messages
SATNAV messages
Other navaid msg
QRU (no message)

OFF
OFF
OFF
OFF

    :               :

OFF

Figure 2-25 EGC setup, station code

18. Enter the navtex station code (A-Z) of the navarea. For details
about navtex stations, consult the operator’s manual of the navtex
receiver.

19. Press [Enter] to close the Station Code window.

20. Using the up/down arrow keys enable/disable reception of
NAVTEX broadcasts and press [Enter].

Note that navtex message types “Coastal navigational informa-
tion”, “Meteorological warning” and “Search and rescue alert”
(they do not appear on the display) cannot be deleted since they
are considered essential to navigation.
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21. Press [Esc] to open the update window.

Setup

EGC Setup

Receive EGC Area
Additional Position

Navarea
Fixed Area
Waypoint (from NAV Equipment)

NAVTEX
Station Code
Type of Message (Can’t reject other report)

Ice reports
Meteo. forecasts
Pilot service
DECCA messages
LORAN messages

OFF
OFF
OFF
OFF
OFF

OMEGA messages
SATNAV messages
Other navaid msg
QRU (no message)

OFF
OFF
OFF
OFF

    :               :

OFF

Update

Yes No

Figure 2-26 EGC setup screen, update window

22. Press [Enter] to select “Yes” and register all EGC settings.

23. Press [Esc] to return to the standby display.

Programming EGC channels

The EGC Channel List in the Setup menu stores EGC channels.

There are currently four EGC channels, one for each satellite. These
four channels are pre-programmed into the unit and marked in the
EGC Channel List with asterisks. When more EGC channels become
available you can add them to the list.

1. Press [F8] to display the Setup menu.

2. Press [9] to display the Configuration menu.

3. Press [3] to display the EGC Channel List.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Setup
Configuration

EGC Channel List

11080* 12580* 10840* 11088*

ENT: set   ESC: quit

Figure 2-27 EGC channel list

4. Current EGC channels are marked with an asterisk. These chan-
nels cannot be changed.

5. With the arrow keys place the cursor where there is no data en-
tered.
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6. Press [Enter] to open the text window.

Setup
Configuration

EGC Channel List

11080* 12580* 10840* 11088*

ENT: set   ESC: quit

Figure 2-28 EGC channel list, cursor displayed

7. Enter EGC channel frequency code.

8. Press [Enter] to close the text window.

9. Press [Esc] to open the update window.

Setup
Configuration

EGC Channel List

11080* 12580* 10840* 11088*

ENT: set   ESC: quit

Update

Yes No

Figure 2-29 EGC channel list, update window

10. Select “Yes” and press [Enter] to register input.

Note:  The EGC channel frequency code range is 8000-14000.
Any frequency code entered which is out of this range will
display "Input Error: Channel No." Clear the error mes-
sage by pressing the [Esc] key. Place the cursor at the in-
valid frequency. Then, press the [Enter] key and enter
correct frequency.

Programming NCS Channels

This section shows you how to add NCS channels to the NCS Chan-
nel List. Up to 19 channels can be listed per each ocean region. Cur-
rently, there are four NCS channels, and they are marked with asterisks
in the list.

Below is the procedure for adding NCS channels, when they become
available.

1. Press [F8] to display the Setup menu.

2. Press [9] to display the Configuration menu.

3. Press [4] to display the NCS Channel List.
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Setup
Configuration

NCS Channel List

No AOR (WEST)
FREQ

11080*

ID

044
0
0
0
0
0
0
0

1
2
3
4
5
6
7
8

ENT: set   ESC: quit

AOR (EAST)
FREQ

12580*

ID

144
1
1
1
1
1
1
1

POR
FREQ

12580*

ID

244
2
2
2
2
2
2
2

IOR
FREQ

10840*

ID

344
3
3
3
3
3
3
3

Figure 2-30 NCS channel list

4. Current NCS common channels are marked with an asterisk. These
channels cannot be changed.

5. Place the cursor where there is no data entered.

6. Press [Enter] to open the text window.

7. Enter NCS channel ID number.

8. Press [Enter] to close the text window.

9. With [/ ] advance the cursor to the frequency column.

10. Press [Enter] to open the text window.

11. Enter NCS channel frequency code.

12. Press [Enter] to close the text window.

13. Press [Esc] to open the update window.

Setup
Configuration

NCS Channel List

No AOR (WEST)
FREQ

11080*

ID

044
0
0
0
0
0
0
0

1
2
3
4
5
6
7
8

ENT: set   ESC: quit

AOR (EAST)
FREQ

12580*

ID

144
1
1
1
1
1
1
1

POR
FREQ

12580*

ID

244
2
2
2
2
2
2
2

IOR
FREQ

10840*

ID

344
3
3
3
3
3
3
3

Update

Yes NoYes

Figure 2-31 NCS channel list, update window

14. Press [Enter] to register input.

Note:  The ID number range is 45-63 and the frequency code range
is 8000-14000. Any ID or frequency entered which is out of
those range will display "Input Error: NCS ID" (for in-
valid ID) or "Input Error: Channel No." (For invalid fre-
quency). Clear the error message by pressing the [Esc] key.
Place the cursor at the invalid ID or frequency code. Then,
press the [Enter] key and enter correct ID or frequency.

15. Press [Esc].
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LES List Operations

The LES List provides for storage of 44 LES names per ocean re-
gion. When the LES table is opened on the Send menu, LES names
entered in this LES List appear along with their IDs. See page 2-21.

Programming the LES list

1. Press [F8] to display the Setup menu.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Setup

1. Distress Alert Setup
2. System Setup
3. Editor Setup
4. Terminal Setup
5. EGC Setup
6. Auto Mode Setup
7. E-Mail Setup
8. Directories
9. Configuration

Figure 2-32 Setup menu

2. Press [9] to display the Configuration menu.

Setup

8. Directories
9. Configuration

Configuration

1. Station List
2. LES List
3. EGC Channel List
4. NCS Channel List
5. E-Mail Service List 

Figure 2-33 Configuration menu

3. Press [2] to display the LES List.

Setup
Configuration

LES List

SOUTHBURY
GOONHILLY

Ctrl+P: print   ENT: list entry   ESC: quit

AOR (WEST)
Name

SOUTHBURY
GOONHILLY

FUCINO

AOR (EAST)
Name

SANTA PAULA

YAMAGUCHI

KUMSAN

POR
Name

YAMAGUCHI
EIK
THERMOPYLAE
ARVI

KUMSAN

IOR
Name

No

1
2
3
4
5
6
7
8

Figure 2-34 LES list
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4. With the arrow keys place the cursor where no data is entered.

5. Press [Enter].

Setup
Configuration

LES List

SOUTHBURY
GOONHILLY

Ctrl+P: print   ENT: list entry   ESC: quit

AOR (WEST)
Name

SOUTHBURY
GOONHILLY

FUCINO

AOR (EAST)
Name

SANTA PAULA

YAMAGUCHI

KUMSAN

POR
Name

YAMAGUCHI
EIK
THERMOPYAE
ARVI

KUMSAN

IOR
Name

No

1
2
3
4
5
6
7
8

Name
ID
Remarks

Erase the Name to delete this LES.

:
:
:

Figure 2-35 LES list, LES entry window

6. Press [Enter] to open the text window.

Name
ID
Remarks

Erase the Name to delete this LES.

:
:
:

Figure 2-36 LES list, text window

7. Enter LES name (maximum 15 characters).

8. Press [Enter].

9. Press [

/

] to advance the cursor to the ID line.

10. Press [Enter].

11. Enter LES ID. The table on page 2-21 shows all current LES IDs.

12. Press [Enter].

13. Press [

/

] to send the cursor to the Remarks line.

14. If desired, enter remarks (up to 20 characters).

15. Press [Esc] to register LES.

16. To return to the standby display, press [Esc] three times.
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Deleting and changing the LES list

1. Press [F8], [9] and [2] to display the LES list.

2. Select the LES you want to edit.

3. Press [Enter].
The cursor should be on the Name line.

: Yamaguchi
: 303
: KDD Japan......

Name
ID
Remarks

Erase the Name to delete this CES.

Figure 2-37 LES selected from LES list

4.  Press [Enter] again to open the window for name entry.

5. To delete/change the LES name, press [Backspace] to erase name
and then press [Enter].

6. To edit an entry, place the cursor on the item you want to edit,
press [Enter], delete with the [Backspace] key, then enter new
data.

7. Press [Esc] to save changes.

8. To return to the standby display, press [Esc] twice.

Printing the LES list

1. Press [F8], [9] and [2] to display the LES list.

2. While pressing and holding down [Ctrl], press [P] to print the
LES list.

LES List ( Printed at 97-08-04  02:33 )

+++++ AOR (WEST) ++++
No.
01
02
12

+++++ AOR (EAST) +++++
No.
01

�Name
SOUTHBURY
GOONHILLY
STATION12

Name
SOUTHBURY

LES ID
001
002
012

LES ID
101

Remarks
USA
UK (NCS, ID044)
NETHERLANDS

Remarks
USA

Figure 2-38 Sample LES list printout

3. To return to the standby display, press [Esc] three times.
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Table 2-1 LES IDs

unemSEL tseWROA tsaEROA ROI ROP

htreP 223 222

yllihnooG 200 201 203

NELET/YB/YLETEN 202

leuqassuA 121 123

muruB 220

dnavaalB 131

roneleT/kiE 400 401 403

asotneS 823 012

augnaT 410 411

assedO 701 703

idaaM 301

ivrA 603

hsiAlammU 601

onicuF 501 533

ealypomrehT 021 503

haddeJ 513

ihcugamaY 300 301 303 302

aluaPatnaS 102

artniS 811

yrubhtuoS 100 101

atA 011 013

nasmuK 803 802

gnitsiaR 511 333

gnijieB 113 112

yrasP 611 613

nehemuoB 413

irubahtnoN 913

21noitatS 210 211 213 212

artsleT/21noitatS 221
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Station List Operations

Programming the station list

The FELCOM 12 provides an “address book” for programming 64
station IDs.

1. Press [F8] to display the Setup menu.

2. Press [9] to display the Configuration menu.

3. Press [1] to display the Station List.

Setup
Configuration

Station List

01
02
03
04
05
06
07
08

abc
xyz
Seagull

Ctrl+P: print

E-Mail
E-Mail
TELEX

abc@ furuno.co.jp
xyz@ furuno.co.jp
584     463609999

Station Name           Type       Code, ID / Address

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Figure 2-39 Sample station list

4. Operate [

/

] to place the cursor on a blank line.

5. Press [Enter].

TELEX
Station Name
Destination Type
Prefix Code
Country Code
Station ID
Modem Type
E-Mail Address
Remarks

Erase the Name to delete this station.

Figure 2-40 Entering a station

6. Press [Enter] to open the window for station name entry.

7. Enter name of station, using up to 15 characters.

8. Press [Enter] to close the window.

9. Press [

/

] to send the cursor to the Destination Type line.
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10. Press [Enter] to open the destination type window.

TELEX
FAX
E-Mail
CSDN
PSDN
X400
DNID
SPEC
TELEX (Prefixed)
FAX (Prefixed)
PSDN (Prefixed)
X400 (Prefixed)
DNID (Prefixed)
SPEC (Prefixed)

Figure 3-41 Selection window for “destination type”

TELEX: Telex communication

FAX: Facsimile service
- to an office facsimile machine

E-Mail: E-mail (electronic mail) Service

CSDN: Circuit Switched Data Network-not used.

PSDN: Packet Switched Data Network
-to an office computer via a data network using X.25
standard.

X400: For future use

DNID: Data Network ID -not used.

SPEC: Ship-to shore requests for safety service, accessed by us-
ing special 2-digit codes (See Note 2 below.)

Note 1:  When FAX is selected, select “T30 (FAX)” in the “Mo-
dem Type” selection display. For further details, refer to
page 4-2.

Note 2: When SPEC is selected on the Type line, the Country
Code line disappears. Enter two-digit codes on the Sta-
tion ID line. Refer to page 4-18 for further details.

11. Set up according to Destination Type selection. The steps which
follow show how to set up for TELEX (Prefixed).

12. Press [Enter] to close the destination type window.

13. [

/

] to advance the cursor to the Prefix Code line for prefixed.

14. Press [Enter] to open the prefix code window.

15. Key in prefix code in two digits.
Note that some services may not be available depending on LES.
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Prefix Code 内　容�

11

12

33

91

Operator’s Assistance（接続援助）�

番号案内／Information�

技術援助�

Automatic Telex Test

16. Press [Enter] to close the prefix code window.

17. Press [

/

] to advance the cursor to the Country Code line for
TELEX, FAX, PSDN.

18. For ship-to-shore telex, enter international telex country code; ship-
to-ship telex, enter ocean region. A list of international telex coun-
try codes begins on page A-1 in the Appendix.

Ocean Region

AOR-East: 581
POR: 582
IOR: 583
AOR-West: 584

19. Press [Enter] to close the window.

20. Press [

/

] to send the cursor to the Station ID line.

21. Press [Enter] to open the window for station ID entry.

22. Enter telex subscriber number (for land) or MES Inmarsat Mo-
bile Number (for ship).
Up to 15 characters, including space, can be entered.

23. Press [Enter] to close the window.

24. Press [

/

] to advance the cursor to the Remarks line.

25. Press [Enter] to open the window for remarks entry.

26. If desired, enter remarks (up to 20 characters).

27. Press [Enter] to close the window.

28. To return to the standby display, press [Esc] three times.
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Editing the station list

1. Press [F8], [9] and [1] to display the Station List.

Setup
Configuration

Station List

01
02
03
04
05
06
07
08

abc
xyz
Seagull

Ctrl+P: print

E-Mail
E-Mail
TELEX

abc@ furuno.co.jp
xyz@ furuno.co.jp
584     463609999

Station Name           Type       Code, ID / Address

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Figure 2-42 Station list

2. Press [
/

] and [Enter] to select the station you want to edit.

3. Press [Enter] to open the station name window.

4. To delete a station, press [Backspace] to erase station name, and
then press [Enter].

5. To edit a station name, place the cursor on the character you want
to edit. Press [Backspace] to erase that character, then enter cor-
rect character.

6. Press [Enter] to save changes.

7. If necessary, select other item, edit it and press [Enter].

8. To return to the standby display, press [Esc] four times.

Printing the station list

1. Press [F8], [9] and [1] to display the Station List.

2. While pressing and holding down [Ctrl], press [P].

No.
01
02
03

Name
abc
xyz
Seagull

Type
E-Mail
E-Mail
TELEX

Dest, ID, Modem / Address
abc@ furuno.co.jp
xyz@ furuno.co.jp
584     463609999

Station List ( Printed at 97-08-04  02:38 )
Remarks

Station Name Subscriber s Number

Country Code

Figure 2-43 Sample station list printout

3. To return to the standby display, press [Esc] three times.
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Entering Own Ship’s Position

When there is no navigation device connected, select OFF on the
Nav Port line in the System Setup menu, as explained on page 2-4,
and enter ship’s position manually as follows:

1. Press [F9] to display the Position menu.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Ship Position

LAT
LON

00:00.00N
000:00.00E

Figure 2-44 Ship position

2. Press [Enter] to open the window for latitude entry.

00:00.00N
000:00.00E

Ship Position

LAT
LON

00:00.00N

Figure 2-45 Ship position, window for entering position

3. Enter latitude and [N] or [S].

4. Press [Enter] to close the window.

5. Press [

/

] to send the cursor to the LON line.

6. Press [Enter] to open the window for longitude entry.

00:00.00N
000:00.00E

Ship Position

LAT
LON 000:00.00E

Figure 2-46 Ship position

7. Enter longitude and [E] or [W].

8. Press [Enter] to close the window.

9. Press [Esc] to open the update window.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

Ship Position

LAT
LON

00:00.00N
000:00.00E

Update

NoYes

Figure 2-47 Ship position, update

10. Press [Enter] to close Ship Position menu.

This position data is also entered on the “Update Distress Alert”
screen. (Refer to page 6-1.)
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Setting Directories

You can designate the directory where to save incoming and outgo-
ing messages as follows:

1. Press [F8] to display the Setup menu.

2. Press [8] to display the Directories menu.

Setup

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

5. EGC Setup
6. Auto Mode Setup
7. E-Mail Setup
8. Directories
9. Configuration

Directories

Message Directory
EGC Message Directory

Figure 2-48 Setup menu, directories

3. Press [Enter] to select “Message Directory”.
Message Directory appears in the command line.

Setup

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup    Position    StopAlarm

5. EGC Setup
6. Auto Mode Setup
7. E-Mail Setup
8. Directories
9. Configuration

Directories

Message Directory
EGC M<DIR><essag>456ABC <DIR>    
e <DIDirectory

Message Directory

To View: SPACE   Make Dir: INS      Remove Dir: DEL

456
901
42
42

868
372

6794

97-07-28  20:53
97-07-28  20:54
97-07-15  02:13
97-07-14  05:42
97-07-15  02:33
97-07-15  02:52
97-07-15  02:59
97-07-15  03:13

     Filename            Size            Date & Time
ABC   <DIR>
ABC281   .
COIEKI    . 
COMTEST.
E0970715.001
E0970715.002
E0970715.003
E0970715.004
 75  Files exist                  578560 bytes free

[B:\                                                                                  ]

Figure 2-49 Setup menu, directories, message directory

4. Press [

/

] to select a directory name.

5. Press [Insert] to make a new directory name.

6. Type a new directory name (for example, MESSAGE).

7. Press [Enter].

8.   Press [  ] .

9. Press [Enter] to select directory name.

10. Press [Esc] twice to return to standby.

/
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E-mail Service List

The E-mail service list provides for E-mail set up. Currently there are
four service stations which handle E-mail. The procedure below de-
scribes how to add service stations to the list.

1. Press [F8] to display the Setup menu.

2. Press [9] to display the Configuration menu.

Setup

8. Directories
9. Configuration

Configuration

1. Station List
2. LES List
3. EGC Channel List
4. NCS Channel List
5. E-Mail Service List 

Figure 2-50 Setup menu, configuration

3. Press [5] to display the E-mail Service List.

Setup

8. Directories
9. Configuration

Configuration

1. Station List
2. LES List
3. EGC Channel List
4. NCS Channel List
5. E-Mail Service List 

E-Mail Service List

Station Name

01
02
03
04
05
06
07
08

AOR.W  AOR.E   POR       IOR

Comsat
PTT Telecom
British Telecom
Stratos
Telstra
EIK

001       101         201         321
012       112         212         312
002       102         202         302
022       122         222         322
022       122         222         322
004       104                        304

Figure 2-51 Setup menu, configuration, E-Mail Service List

4. Select blank space in Station Name column and press [Enter].
E-mail setup display appears.

Setup

8. Directories
9. Configuration

Configuration

1. Station List
2. LES List
3. EGC Channel List
4. NCS Channel List
5. E-Mail Service List 

E-Mail Service List

Station Name

01
02
03
04
05
06
07
08

AOR.W  AOR.E   POR       IOR

Comsat
PTT Telecom
British Telecom
Stratos
Telstra
EIK

001       101         201
012       112         212         312
002       102         210
022       122         222         322

Service Station Name
Service ID
LES ID(AORW)
(AORE)
(POR)
(IOR)
To:
Cc:
Subject:
Separator
Attach File(MIME) ON

Figure 2-52 E-mail setup
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5. Press [Enter] to open the window for service station name entry.

Setup

8. Directories
9. Configuration

Configuration

1. Station List
2. LES List
3. EGC Channel List
4. NCS Channel List
5. E-Mail Service List 

E-Mail Service List

Station Name

01
02
03
04
05
06
07
08

AOR.W  AOR.E   POR       IOR

Comsat
PTT Telecom
British Telecom
Stratos
Telstra
EIK

001       101         201
012       112         212         312
002       102         210
022       122         222         322

Service Station Name
Service ID
LES ID(AORW)
            (AORE)
            (POR)
            (IOR)
To:
Cc:
Subject:
Separator
Attach File(MIME) ON

Figure 2-53 Service station list

6. Type service station name.

7. Press [Enter] to close the window.

8. Press [

/

] to place the cursor on the Service ID line.

9. Press [Enter] to open the window for service ID entry.

10.  Type Service ID.
 Service ID is station address .

11.  Press [Enter] to close the window.

12.  Press [

/

] to place the cursor on the LES ID line.

13.  Press [Enter] to open the window for LES ID entry.

14.  Type LES ID of AOR-W.

15.  Press [Enter] to close the window.

16.  Follow steps 12 thru step 15 for AOR-E, POR and IOR.

17.  Press [

/

] to place the cursor on the “To:” line.

18.  Press [Enter] to open the window for “to” header entry.

19.  Type proper “To” header (for example, TO:, to+, etc.).

20.  Press [Enter] to close the window for “cc” header entry.

21.  Press [

/

] to place the cursor on the “Cc:” line.

22.  Press [Enter] to open the window for “cc” header entry.

23.  Type proper “Cc” header (for example, CC:, cc+, etc.).

24.  Press [Enter] to close the window for “subject” header entry.

25.  Press [

/

] to place the cursor on the “Subject:” line.

26.  Press [Enter] to open the window for “subject” header entry.

27.  Type proper “Subject” header (for example, Subject:, subject+,
etc.).

28.  Press [Enter] to close the window for separator entry.
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29.  Press [

/

] to place the cursor on the “Separator” line.

30.  Press [Enter] to open the window for separator entry.

31.  Type proper Separator (for example, blank space, STX:, etc.).

32.  Press [Enter] to close the window.

33.  Press [

/

] to place the cursor on the “Attach File (MIME)” line.

34.  Press [Enter] to open the selection window.

35.  Select “ON” or “OFF”.

36.  Press [Enter] to close the selection window.

37.  Press [Esc] three times to return to the standby display.

E-mail Setup

Select the LES where to forward E-mail. Also,you will need
to register with the LES to get E-mail services.

1. Press [F8]  to display the Setup menu.

2. Press [7] to  dislay E-mail Setup screeen.

Setup

6. Auto Mode Setup
7. E-Mail Setup
8. Directories
9. Configuration

E-Mail Setup

Station Name

01

AOR.W  AOR.E   POR       IOR

Comsat 001       101         201

                Figure 2-54  E-mail Set up display

3. Press [Enter] to open the selection window.

Setup

6. Auto Mode Setup
7. E-Mail Setup
8. Directories
9. Configuration

E-Mail Setup

Station Name

01

AOR.W  AOR.E   POR       IOR

Comsat 001       101         201
Station Name

01
02
03
04
05
06
07
08

AOR.W  AOR.E   POR       IOR

Comsat
PTT Telecom
British Telecom
Stratos
Telstra 022       122         222         322
EIK 004       104                        304 

001       101         201         321
012       112         212         312
002       102         202         302
022       122         222         322

                  Figure 2-55  E-mail Operating LES

4. Selecter the LES where to forward E-mail.
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5. Press [Enter] to the update window.

Setup

6. Auto Mode Setup
7. E-Mail Setup
8. Directories
9. Configuration

E-Mail Setup

Station Name

01

AOR.W  AOR.E   POR       IOR

Comsat 001       101         201
Station Name

01
02
03
04
05
06
07
08

AOR.W  AOR.E   POR       IOR

Comsat
PTT Telecom
British Telecom
Stratos
Telstra
EIK

001       101         201
012       112         212         312
002       102         210
022       122         222         322

Update

NoYes

                   Figure 2-56  update window

6. Press Enter again.

7. Press ESC to return the stand by display.
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FILE OPERATIONS

This chapter describes how to prepare, edit, save and print files (mes-
sages).

Preparing a Message

There are two types of files: routine and confidential.

Messages can be assigned a file name and saved to a floppy disk for
later use. A message may contain maximum 124×254 characters (32
Kbytes).

Preparing a routine message

1. Press [F1] to display the File menu.

Figure 3-1 File menu

2. Press [1] to select New. The display should now look something
like Figure 3-2.

Figure 3-2 Text editor screen
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Note: If the text editor screen does not appear and “close” screen
appears, see “Opening a file where a working area is oc-
cupied” on page 3-11.

3. The cursor is on the first line. Type your message.

Preparing a confidential message

If communicating with another FELCOM 12, you can prepare a con-
fidential message by entering “S???-addressee code(-password):” in
first line of message text. You can also receive confidential messages
containing this header from a land subscriber or any MES which uses
the FELCOM 12.

There are two types of confidential messages: message with addressee
code and message with both addressee code and password.

When a FELCOM 12 receives a confidential message, the message
is not displayed and printed immediately. To display or print the con-
tents of a confidential message, the recipient executes the key se-
quences shown on page 4-23.

Explanation of addressee code and password

Caller and recipient agree beforehand on both the addressee code and
the password. The addressee code can be the title of the recipient; for
example, CAPTAIN. The password could be the classification of the
message; for example, SECRET.

Preparing message with addressee code

Type S, 3 question marks, hyphen, addressee code, colon followed
by text of message.

Figure 3-3 Addressee code

Preparing message with both addressee code and password

Type S, 3 question marks, hyphen, addressee code, hyphen, pass-
word, colon followed by text of message.

Figure 3-4 Addressee code and password
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When the recipient receives a message with both addressee code and
password, he must enter the password to view contents of the mes-
sage.

Editor menu setup

The Editor menu sets the parameters of the text editor.

1. Press [F8] to display the Setup menu.

2. Press [3] to display the Editor Setup menu.

Figure 3-5 Editor setup menu

3. Figure 3-5 shows the default editor setup settings. To change set-
tings, select item with arrow keys, press [Enter] to open selection
window, and select settings with arrow keys. After selecting set-
tings, press [Enter].

Text Mode: Select “Telex” or “ASCII”.

Edit Mode: Select “Insert” (insert character at cursor location)
or “Overwrite” (write over character at cursor lo-
cation).

Word Wrap: Turns on/off hyphenation at end of line.

Line No.: Turns line number display on or off.

Tab Width: Sets horizontal tab width; 2, 4 or 8 tabs per line.

Column Width: Select Telex (69 Fixed) or ASCII (40 to 80).

Cursor Type: Selects cursor appearance, either  (Block) or un-
derline.
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Scroll: Sets how much the screen moves up over the page
(Full Screen or Half Screen) when [PgUp] or
[PgDn] key is operated.

Figure 3-6 Text editor screen

Cutting and pasting text

1. Place the cursor on the first character of the text to be cut.

2. Highlight the text to be cut by pressing [ ] while pressing and
holding [Shift]. You can use the right and left arrow keys to adjust
the highlight. The figure below shows the appearance of high-
lighted text.

Figure 3-7 Appearance of highlighted text

3. Press [F2] to select the Edit menu.

Figure 3-8 Edit menu
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4. Press [1] to select Cut. The highlighted text is cut and the remain-
ing text is reformatted. If a mistake is made, you can immediately
restore the text by pressing [Insert].

5. To move text to a new location after it has been cut, place the
cursor at the exact spot in the message where the cut text is to
start. When the text cursor is placed correctly, press [F2] and then
[3] (Paste).

Copying and pasting text

1. Select the text you want to copy.

Figure 3-9 Appearance of highlighted text

2. Press [F2] to display the Edit menu.

3. Press [2] to select Copy. The text selected is copied to the internal
clipboard.

4. Place the cursor at the exact spot on the message where the cop-
ied text is to start.

Figure 3-10 Cursor selects location where to paste text
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5. Press [F2] followed by [3]. The text is placed at the cursor loca-
tion.

Figure 3-11 Text pasted at cursor location

Insert (with Citation)

When you reply to a received message, you can insert the received
message. “>”  is placed at the head of the received message to distin-
guish it from your message.

Select All

Selects the entire current file for cut and copy.

Search and Replace

Searches a specified word. Replaces a word with a different word or
character.

Go to line

Moves the cursor to the desired line in the current file.
1. Top of text
2. End of text
3. Go to line: Specify line number

Time or Pos. ins

Inserts time or position in a sentence.
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Saving a Message

Formatting a floppy disk

To save a message to a floppy disk the disk must be formatted. For-
matting prepares the disk no information can be written to its surface.

1. Insert a blank floppy disk into the disk drive.

2. Press [F1].

3. Press [8].

Figure 3-12 Format disk screen

4. Select media type.

5. Press [Enter].

Figure 3-13 FD Format confirmation screen

6. Select “Yes” to format the disk. Press [Enter] to begin formatting.

Note: If there is no floppy disk in the drive, “FD not inserted in
drive. Press any key to escape.” appears on the display.

7. “Now Formatting” appears on the screen during formatting.

8. When formatting is completed (about one minute), “Formatting
Completed.” appears on the display. You can now return to the
standby display by pressing any key.
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Saving a message

You can save a message two ways: Save it without losing your place
on the screen (called “save”), or save it before clearing the screen
(called “close”).

Save message, retain place on screen

1. Press [F1] to display the File menu.

2. Press [4]. The screen should look something like Figure 3-14.

Figure 3-14 Save screen

3. Enter a file name, up to eight characters with extension name (three
characters), as shown below.

Figure 3-15 Configuration of file menu

4. Press [Enter]. “SAVING” appears on display.
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Save message, clear screen

1. Press [F1] to display the File menu.

2. Press [3]. The prompt “Save this message?” appears on the screen.

Figure 3-16 File menu, close file prompt

3. Press [Enter].

Figure 3-17 Save screen

4. Enter a file name.

5. Press [Enter].
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Opening a File

The internal memory provides two working areas where you can load
one file each. Only one file can be displayed at a time, however you
can easily switch between files.

Figure 3-18 Internal memory

Opening a file

1. Set the floppy disk containing the file you wish to open in the
disk drive.

2. Press [F1] to display the File menu.

3. Press [2]. The screen shows a list of the files stored in the floppy
disk.

4. Select a file.
To view a portion of a file, press the space bar.

Figure 3-19 Partial view of a file

5. Press [Enter].

6. The message “Loading” appears on the screen during loading. A
few moments later the contents of the file appear on the screen
and the title bar shows the file name. You may repeat the above
procedure to load a second file into a working area.
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Switching between files

You can switch between files by selecting Change Window in the
Edit menu. Figure 3-20 illustrates how to switch between files with
Change Window.

Figure 3-20 How the change window feature works

Opening a file where a working area is occupied

When you try to load a file into an occupied working memory, the
display asks you if you want to save the file in that memory before
clearing the display.

Figure 3-21 Prompt for closing a file

To save the file, press [Enter]; select “No” and press [Enter] if you do
not need to save the file. The file screen is erased and then the un-
titled window appears.

Figure 3-22 Save screen

Enter file name followed by [Enter]. The editing screen appears.
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Saving a File Under a New Name

1. Call up a file.

2. Edit the file.

3. Press [F1].

4. Press [3] (or [4]). “Save this message?” prompt appears. [3] saves
file and closes screen; [4] saves file and keeps position on screen.

Figure 3-23 Save screen, prompt for saving a message before
closing

5. Press [Enter].

6. Press [Backspace] to delete original file name. Enter file name
for new file.

Figure 3-24 Save screen

7. Press [Enter].

Note: Should you decide to save the file under the original name,
skip step 6. The following screen appears.
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Figure 3-25 Save screen, overwrite file name

Printing a File

You can print out a hard copy of a file stored in a floppy disk.

1. Press [F1] to display the File menu.

2. Press [7]. A list of files stored on the disk appears.

Figure 3-26 Sample print screen

3. Select a file. To get a partial display of the file, tap the space bar.

4. Press [Enter].
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Combining Files

In the procedure below we’ll combine file A and B.

1. Open file A.

2. Open file B. File B appears on the display.

3. Place the cursor at the beginning of the file. While pressing and
holding down [Shift] press [ ] to highlight the entire file. (You
can also select a portion of the file.)

4. Press [C] while holding down [Alt]. This places file B on the clip-
board.

5. Press [V] while holding down [Alt]. File B is erased and File A
appears on the display.

6. Press [→] while holding down [Fn] followed by [Enter] to place
the cursor at the end of the file.

7. Press [Insert].
The file B is inserted at the end of the file A.

Deleting a File

1. Press [F1] to display the File menu.

2. Press [5]. A list of files stored on the disk appears.

Figure 3-27 Sample delete screen

3. Select the file you want to delete. To verify the contents of that
file, tap the space bar.
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4. Press [Enter]. The prompt “OK to delete file?” appears.

Figure 3-28 Prompt for verification of file delete

5. Press [Enter] to delete the file, or press [ ] and [Enter] to escape.

MIME (Multipurpose Internet Mail Extensions)

When you can't read an attached file in the Log menu, you may de-
code it with MIME as follows:

1. Press [F1].

2. Press [9].

Figure 3-29 File, decode

3. Select the file you want to decode.

4. Press [Enter].
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Rename

Do the following to change file name.

1. Press [F1].

2. Press [6].

Figure 3-30 File, rename

3. Select a file you want to rename.

4. Press [Enter].

Figure 3-31 Rename window

5. Delete old file name and then type new file name.

6. Press [Enter].
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INMARSAT-C COMMUNICATIONS

This chapter explains how to transmit and receive in the Inmarsat-C
system.

Before conducting any communications, be sure to login with the
NCS in your area.

To transmit E-mail, register with the LES provider. E-mail charges
are calculated separately.

Transmitting

To transmit a message, you first create the message, attach the ad-
dress of the recipient and send it to the LES. The address of the re-
cipient in the Inmarsat-C system is his telex number for land-line or
MES Inmarsat Mobile Number (IMN) for ship.

The message can be one you’ve just prepared or one stored on a floppy
disk. (Messages cannot be transmitted by means of direct keyboard
input.)

Code description

Code can be specified at the IB-581 or PC.

IA5: International alphabet No. 5, ASCII code (7 bit).
Specify this code to transmit English containing lower case
alphabet.

ITA2: No. 2 international communications alphabet (5 bit).
Specify this code for message which contains only No. 2 in-
ternational communications alphabet (see A-11). ITA2 code
is transmitted faster than IA5 code.
Land-based telex equipment uses ITA2. The LES converts all
codes into ITA2. Code which cannot be converted is shown
with a question mark (?).

DATA: Data (8 bit). Use this code to transmit data.
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Table 4-1 Message, subscriber destination and code

Message Subscriber Destination Type Code Remarks
English Inmarsat C Sta. TELEX IA5

Telex TELEX ITA2

Fax PSTN IA5 Modem type is T30 FAX.

E-mail E-Mail IA5

Russian Inmarsat C Sta. PSDN DATA

Telex TELEX ITA2
THERMOPYLAE (305)  and

PEATH (222)
Fax Not available

E-mail E-Mail DATA

Japanese Inmarsat C Sta. PSDN DATA

Telex Not available

Fax Not available

E-mail E-Mail DATA

Data Inmarsat C Sta. PSDN DATA

Land Network PSDN DATA

Transmitting prepared message

This section explains routine telex transmission. For distress com-
munication, see page 6-1.
For 2-digit code services and PSTN (FAX) communication, see page
4-17, respectively.

common procedure for transmitting a message

1. Prepare message on the screen.

2. Press [F3] to display the Transmit menu.

Figure 4-1 Transmit menu
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3. Press [Enter] or [1] to display the Transmit Message menu. The
cursor is on the Priority line and “Normal” is selected.

Figure 4-2 Transmit message menu

Note: An error message may appear under the conditions below:

Unit is not logged-in. -Error message: Cannot start to send.
(not logged-in)

Unit operates as an EGC-only receiver-Error Message:
Cannot start to send. (EGC receiver)

The message file line displays “Message now being edited” when
a file is currently displayed.

4. Press [ ] three times to place the cursor on the Destination Type
line.

5. Press [Enter] to open the selection window.

6. Select Destination Type among “TELEX”, “FAX” or “SPEC
(Prefixed)”.

Figure 4-3 Transmit message menu, destination type window

7. Press [Enter] to close selection window.
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8. Follow instructions below for TELEX (Prefixed), or go to page4-
5 for FAX or E-Mail.

Destination type: TELEX (Prefixed)

(1) Press [ ] to place the cursor on the Prefix Code line.

(2) Press [Enter] to open the window for prefix code entry.

(3) Key in prefix code in the digits.
Note that some services may not be available depending on
LES.

Prefix Code Function

11 Operator's Assistance

12 Dial Guide

33 Technical Assistance

91 Automatic Telex Test

(4) Press [Enter] to close the window.

(5) Press [ ] to place the cursor on the Country/Ocean Code
line.

(6) Press [Enter] to open the window for country/ocean code entry.

(7) Type either international telex country code of recipient (ship-
to-shore) or ocean region (ship-to-ship). A list of international
telex country codes begins on page A-1 in the Appendix.

Ocean Region

AOR-East: 581
POR: 582
IOR: 583
AOR-West:584

Figure 4-4 Transmit message menu, country/ocean code window

(8) Press [Enter] to close the window.
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(9) Press [ ] to send the cursor to the Station ID line.

(10)Press [Enter] to open the window for station ID entry.

Figure 4-5 Transmit message menu, station ID window opened

(11)Type either recipient’s telex subscriber number (ship-to-shore)
or receiving MES INM (ship-to-ship).

(12)Press [Enter] to close the window.

(13)Go to step 9 at the top of page 4-7.

Destination type: FAX

(1) Press [ ] to advance the cursor to the Modem Type line.

(2) Press [Enter] to open the selection window.

Figure 4-6 Transmit message menu, modem type window opened

(3) Select “T30”.

(4) Press [Enter] to close the selection window.

(5) Go to step 9 at the top of page 4-7.

Destination type: E-mail

(1) Press [ ] to advance the cursor to the Address line.



 4-6

(2) Press [Enter] to open the window for address entry.

Figure 4-7 Transmit message menu, address window

(3) Type recipient’s E-mail address.

(4) Press [Enter] to close the window.

(5) Press [ ] to advance the cursor to the Subject line.

(6) Press [Enter] to open the window for subject entry.

Figure 4-8 Transmit message menu, subject window opened

(7) Type subject.

(8) Press [Enter] to close the window.

(9) Press [ ] to advance the cursor to the Attach File line.

(10)Press [Enter] to open the select File window.
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Figure 4-9 Transmit message menu, select file window opened

(11)Press [Enter] to open the file list window.
To change drive on a PC, move the cursor to the command
line, type drive name (for example, “A”), and move the cur-
sor to anywhere in the File Name column.

(12)Press [Enter] to select file and close the file list window.

(13)Press [Esc] to close the select file.
Go to step 9 at the top of the next page.

procedure for transmitting a message (con’t from page 4-5 )

9. Press [ ] to advance the cursor to the LES ID line.

10.Press [Enter] to open the selection window.

Figure 4-10 Transmit message menu, LES ID window opened

Note: If the LES ID entered is invalid, “Cannot use this LES.
Please check network configuration.” appears.

11. Select LES ID.

12.Press [Enter] to close the selection window.
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13.Press [ ] to send the cursor to the Option line.

14.Press [Enter] to open the option window.

Figure 4-11 Transmit message menu, option window opened

15.Press [Enter] to open the selection window.

16.To receive confirmation from the LES when message has been
delivered to recipient, select ON. If not required, select OFF.

17.Press [Enter] to close the selection window.

18.Press [ ] to send the cursor to the Send Delay line.

19.Press [Enter] to open the window for send delay entry.

20.To send a message after a certain delay enter a time up to 99 hours
59 minutes.
(The Send Delay is used to time message arrival to suit recipient’s
office hours.)

21.Press [Enter] to close the window.

22.Press [ ] to go to the Delivery Delay line.

23.Press [Enter] to open the selection window.

24.The Delivery Delay line requests the LES for “Immediate” or
“Deferred” transmission to the recipient designated. Select either
immediate or deferred. For information on this service, consult
with LES to which message is to be sent.

25.Press [Enter] to close the selection window.

26.Press [ ] to send the cursor to the Code line.

27.Select “IA5”, “ITA2” or “DATA”.
 Normally, IA5.

28.Press [Enter] to close the selection window.

29.Press [ ] to place the cursor on TRANSMIT..

30.Press [Enter] to open the start window.
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31.Press [Enter] to transmit the message to the message buffer. (To
escape, select No and press [Enter].) The message “Message is
entered in sending Buffer.” appears and the message prepared is
printed.

Note: The message buffer can only hold one message. However a
second message may be sent to the buffer by assigning a
Send Delay to it.

When the message buffer is full, “Cannot enter this mes-
sage to sending Buffer.” appears to alert you.

32.Press any key to return to the standby display.

The message(s) will be transmitted according to Send Delay setting.
“Current State: SENDING” appears at the bottom of the screen dur-
ing transmission.

If the message was transmitted successfully “Successful Sending mes-
sage” appears and its particulars are sent to the Display Log.

TRANSMIT MESSAGE STATUS

The terminal unit displays transmit message status as follows:

“Message Send failed.” This appears if the message could not
be transmitted because of technical reasons such as satellite
malfunction, signal degradation, or no reply from LES. Try to
transmit the message again.

“Message Send rejected.” This appears when the LES rejects
the message because of non-technical reasons such as unpaid
subscriber’s fee.

“Message Send pending.” This appears when the circuits at
the LES are busy. Your message will be transmitted when a
circuit becomes clear.

Transmitting message stored on floppy disk
(multiple address)

1. Close any open files.

2. Insert floppy disk containing file to be sent. (Be sure to insert the
floppy disk completely in the drive. Otherwise, “FD not inserted
in drive.” appears.)

3. Press [F3] to display the Transmit menu.
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Figure 4-12 Transmit menu

4. Press [1] to select Transmit Message.

    The cursor is on the Priority line and “Normal” is selected.

Figure 4-13 Transmit message menu

5. Press [ ] to advance the cursor to the Message File line.

6.   Enter the file name manually, or select it from the message file list
of the floppy disk as follows.

a) Press [Enter] to display Message File list.

Figure 4-14 File list
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b) Select a file.

c) Tap the space bar to display a portion of the file in the view
window.

d) Press [Enter]. The Message File screen appears with the file
selected.

7. Press [ ] to advance the cursor to the Station Name line.

8. Press [Enter] to open the Station List.

Figure 4-15 Select station screen

9. Select station and press [Enter].
To select more than one station, press [Space] bar after selecting
station. An asterisk appears next to station(s) selected.

Note :Different types or prefix code of messages cannot be tranmitted
 simultneously.

Figure 4-16 With asterisk mark

10.Press [ ] key to advance the cursor to the LES ID line.

11. Press [Enter] to open the LES Table.
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Figure 4-17 LES list

Figure 4-18 Sample LES table

a) Select LES.
b) Press [Enter].
c) The Transmit Message screen appears with selected LES dis-

played on the LES ID line.

12.Follow steps 13 thru 28 in the previous section.

13.Press [ ] to place the cursor on TRANSMIT..

14.Press [Enter] twice to transmit the message.

Figure 4-19 Transmit message menu
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Note: If a file name which was entered manually does not exist
when you attempt to transumit the file at step 13. “Input
Error: Message File” appears. Press any key to erase the
error message then enter correct name.

Canceling transmission

As noted earlier a transmit message is held in the buffer, usually until
it is transmitted satisfactorily. To cancel transmission on a message
held in the buffer, do the following:

1. Press [F3] to display the Transmit menu.

2. Press [2] to display the Cancel screen.

Figure 4-20 Sample cancel screen

Send status

Waiting: Waiting to transmit message.

Sending: Now sending message.

Fail: Failed transmission

Rejected: Message rejected by LES.

Pending: LES circuits occupied.

3. Select message you want to cancel.
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4. Press [Enter] to open the Cancel window.

Figure 4-21 Cancel window

5. Press [Enter] to cancel a message from transmission, or select
“No” and press [ Enter] to escape from the Cancel menu.

6. Press [Esc] to return to the default display.

Confirming delivery status (message status list)

You can automatically receive delivery status of messages you send
to a LES, by selecting “Confirming ON” in the Send Message menu.
(Delivery Status can also be confirmed manually. See page 4-16.)
Messages transmitted which request delivery status appears in the
Message Status List.

The Message Status List holds delivery status information for 30 mes-
sages. When the list is full, the oldest entry is deleted to make room
for the latest.

1. Press [F3].

Figure 4-22 Transmit menu
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2. Press [3] to display the Request Delivery Status menu.

Figure 4-23 Sample request delivery states

Message status list description

No.: Message number

Message File: File name. For no file name, “edit msg. 00X” appears
(X = number from 001-999).

Station: Name of remote party (recipient)

LES: The LES which received the message.

Priority: Normal or distress

Send Status: The transmission status from the MES (own ship) to
the LES; waiting or sending, and data and time of
transmission for messages transmitted.

Delivery: The delivery status from the LES to the recipient.
Complete: Message transmitted successfully
White space: Delivery status not yet received
Reason for no delivery:

OCC(002): Delivery tried (twice), but recipient busy.
ABS: Absent subscriber
BK: Message aborted
BMC: No end of message or end of transmission received
DER: Out of Order
DTE: Remote DTE clearing
EOS: Element of Service not subscribed (E-mail)
FMT: Format error
IAB: Invalid answerback
INC: Inconsistent Request (E-mail)
INF: Call the Network Information service
INV: Invalid Call
ITD: Awaiting delivery
LDE: Maximum message length exceeded
LPE: Local Procedure Error
NA: Access Barred
NC: Network Congestion
NCH: Subscriber’s number has been changed
NP: Not Obtainable
NRC: Reverse charging acceptance not subscribed
RIS: Recipient Improperly Specified (E-mail)
RDI: Redirected call
RPE: Remote Procedure Error
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RSB: Retransmission still being attempted
TMD: Maximum number of addresses exceeded
UNK: Unknown status (for example  when the Logical

channel number is zero)

Note: Some LES do not use certain codes.

Manually requesting delivery status

You can request a LES for delivery status of a message you have
transmitted there within the past 24 hours.

1. Press [F3].

2. Press [3] to display the Request Delivery Status display.

Figure 4-24 Request delivery status display

3. Select a file.

4. Press [Enter]. A prompt asks you if you want to request delivery
status on that message.

Figure 4-25 Sample message file list

5. Press [Enter] to request status. “Request started” appears on the
display. (To cancel request, select “No” and press [Enter].)

6. “Press any key.” appears on the display; press any key to return to
the standby display.

Several minutes later the reply from the LES appears in the Delivery
column of the Request Delivery Status screen.
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The 2-digit code services

A range of special safety and general maritime services, known as
the 2-digit code services, may be received. The list on the next page
shows the 2-digit code services available.

To access a 2-digit code service;

1. Using the text editor, prepare message requesting a 2-digit code
service. (Refer to next page.)

2. Press [F3] to display the Transmit menu.

3. Press [Enter] to display the Transmit Message.

Figure 4-26 Transmit message menu

4. Press [ ] three times to place the cursor on the Destination Type
line.

5. Press [Enter] to open the selection window.

6. Select “SPEC” (Special).

7. Press [Enter] to close the selection window.

8. Press [ ] to place the cursor on the Station ID line.

9. Press [Enter] to open the window for station ID entry.

10.Key in 2-digit code referring to the tables on the next page.

11. Press [Enter] to close the window.



 4-18

For maritime safety service;

32 Medical advice Used for requesting medical advice.

38 Medical assistance Used for requesting medical assistance.

39 Maritime assistance Used for requesting maritime search and rescue 

assistance.

41 Meteorological reports Necessary for ease of addressing weather reports from 

ships to meteorological centers.

42 Navigational Hazards and 

warnings

Used for making urgent navigational meteorological 

danger reports.

43 Ship position reports Used for routing of messages to ship safety reporting 

systems.

For general utility;

31 Maritime enquiries Desirable for requesting information including service 

offerings.

33 Technical assistance Desirable for addressing technical enquiries to 

appropriate personnel.

37 Time and charges requested at 

end of call

Desirable for mobile operator when sending traffic for a 

third party.

12.Press [ ] to advance the cursor to the LES ID line.

13.Press [Enter] to open the LES table.

14.Press [Enter] to select LES ID.

15.Press [ ] to place the cursor on TRANSMIT..

16.Press [Enter]. A prompt asks if it is alright to start transmission.
(The Confirmation, Send Delay and Delivery Delay remain “ON”,
“00:00” and “Immediate”, respectively. If necessary, change these
settings before pressing [Enter].)

17.Press [Enter] to transmit the message prepared.

18.Press any key to return to the standby display.

The message will be transmitted according to Send Delay setting.
“Current State: SENDING” appears at the bottom of the screen
during transmission.

If the message was transmitted successfully “Successful Sending
message” appears and its particulars are sent to the Display Log.

Note 1: At present, not all LESs are offering the 2-digit code ser-
vices. To find out which LESs are offering the services, con-
tact the LES Operations Coordinator directly.

Note 2: Some 2-digit code services may be provided free of charge by
LESs, while other services are chargeable, in some cases at
reduced rates. For information, contact the LES directly.
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Inserting the destinations of a fax terminal

You can send a text message to a Group 3 type fax terminal which is
connected to the international PSTN (telephone) land line, provided
the LES selected supports fax delivery.

1. Prepare message. (To send stored file, close any open files.)

2. Press [F3] to display the Transmit menu.

3. Press [1] to select Transmit Message.
The cursor is on the Priority line and “Normal” is selected.

4. Press [ ] to advance the cursor to the Message file line.

5. The message file line displays “Message now begin edited.” when
a file is the currently displayed. To send a file stored on a floppy
disk, select the file from the file list.

6. Press [ ] to advance the cursor to the Destination Type line.

7. Press [Enter] to open the selection window.

8. Select “FAX”.

9. Press [Enter] to close the selection window.

Figure 4-27 Transmit message menu, FAX selected

10.Press [ ] to advance the cursor. The cursor is now on the Coun-
try/Ocean Code line.

11. Press [Enter] to open the window for country/ocean code entry.

12.Key in international telephone code of recipient. A list of interna-
tional telex/telephone country codes begins on page A-1 in the
Appendix.

13.Press [Enter] to close the window.

14.Press [ ] to send the cursor to the Station ID line.

15.Press [Enter] to open the window for station ID entry.

16.Enter facsimile number.
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17.Press [Enter] to close the window.

18.Press [ ] to send the cursor to the Modem Type line.

19.Press [Enter] to display the list of modem types.

20.Press [Enter] to select “T30”. (Other modem types are not sup-
ported.)

21.Press [ ] to advance the cursor to the LES ID line.

22.Press [Enter] to open the LES Table.

23.Select LES ID.

Note: If the LES ID entered is invalid, “Cannot use this LES.
Please check network configuration.” appears.

24.Press [Enter] to close the LES Table.

25.Press [ ] twice to place the cursor on TRANSMIT..

26.Press [Enter] twice to send the message to the message buffer.
(To escape, select No and press [Enter].) The message “Message
is entered in sending Buffer.” appears.
At the same time, the message prepared is printed.

27.Press any key to return to the standby display.

The message(s) will be transmitted according to the Send Delay set-
ting. “Current State: SENDING” appears at the bottom of the screen
during transmission.

When the message is transmitted successfully “Successful Sending
message” appears and its particulars are sent to the Display Log.

Receiving

When a message is received

Each time the FELCOM 12 receives a message it automatically reg-
isters, saves, prints (except messages with passwords) and files it.

1) registration

Each message received is assigned a receive message number. This
number is also used when the file is saved to a floppy disk.
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2) display log

The Display Log shows message number, priority, date and time of
transmission, LES ID and file size (in bytes) of the latest 50 received
and transmitted messages.

3) printing

Printing of a message begins (except messages with passwords) as
soon as it is received.

4) saving and filing

The DTE saves and files a receive message to the Display Message
List. (For installations with both a main and a 2nd DTE, you may
select where to store receive messages, on the system setup menu.)
The Display Message List shows the following:

Receive message no.
LES ID
Priority
File size (in bytes)
Message classification
Password for confidential messages
Date and time of transmission
Status

Setting the receive alarm

An audible alarm may be set to ring when a routine message is re-
ceived. The factory setting is OFF.

1. Press [F8] to display the Setup menu.

2. Press [6] to display the Auto Mode Setup.

Figure 4-28 Auto mode setup menu

3. Press [ ] to send the cursor to the Receive Alarm line.

4. Press [Enter] to open the selection window.

5. To enable the alarm, select ON. The alarm will be released for
one second when a message is received.
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6. Press [Enter] to close the selection window.

7. Press [Esc] twice.

Displaying receive messages

When you can't read an attached file in Log menu refer to page
3-15.

1.   Press [F6].

2. Press [2] to display list of receive messages.

Figure 4-29 Sample display message screen

Display message list description

Message No.: Receive message no.

LES: LES name

Priority: Normal or distress

Size: Size of file in bytes

Addressee: Addressee code appears for confidential mes-
sages. Nothing appears for routine messages.

Rec date & time: Date and time message was received.

Status: Printed: message printed
Saved: message saved to floppy disk
No display: not yet printed confidential mes-
sage, or printer malfunction

Memory available: Memory available in DTE

3. Select a file. To get a partial display of a file selected, tap the
space bar. A part of the file appears in the View Window.
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4. Press [Enter] for routine messages and messages with addressee
code (no password).
Your selection appears on the display.

 Figure 4-30 Sample receive message

5. For messages with both addressee code and password, a Pass-
word window appears. Enter the password corresponding to the
addressee code and then press [Enter]. If the password is entered
incorrectly an alarm sounds. Reenter the password.

Figure 4-31 Location of password

The screen can be scrolled with the up and down arrow keys.

Printing receive messages

1. Follow steps 1 thru 6 in “Displaying receive messages”.

2. While pressing and holding down [Ctrl], press [P]. The printer
starts printing the message on the screen.

 Figure 4-32 Sample receive message printout
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Saving receive messages to a floppy disk

1. Press [F6].

2. Press [2] to display the Receive Message Log.

Figure 4-33 Sample delete message screen

3. Select a file. To display a portion of the file selected, tap the space
bar.

4. For confidential messages enter password. This password will also
be saved to the floppy disk.

5. Press [Enter] to copy the file to the floppy disk. “Saving to FD”
appears during saving.

Note: If a file by that name already exists on the floppy disk,
“A file by that name already exists on FD.” appears.

Automatically saving receive messages

1. Press [F8].

2. Press [6] to display Auto Mode Setup menu.

Figure 4-34 Auto mode setup menu

3. Press [ ] to select “Auto Telex MSG Save”.

4. Press [Enter] to open the selection window.

5. Select “ON”.

6. Press [Enter] to close the selection window.

7. Press [Esc] twice.
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The drive and directory where to save receive messages and created
files can be specified with “MSG Directory”. The default setting is as
follows;

For IB-581 B:\
For PC “MAIL” directory in directory which stores program

files

Note: For IB-581 do not specify the ROM disk (drive A) as the “MSG
directory.” The ROM disk can only be written to 1000 times.

Receive messages are automatically assigned a file name as described
on page 4-20.

EGC messages can also be automatically saved. EGC messages are
automatically assigned a file name and they begin with E.

Deleting receive messages

1. Press [F6].

2. Press [2] to display list of receive messages.

Figure 4-35 Sample delete message screen

3. Select the message you want to delete. To display a part of a mes-
sage (except confidential messages), tap the space bar.

4. To view a portion of a confidential file, enter the password and
then tap the space bar.

5. Press [D]. You are asked to confirm.

6. Press [Enter] to delete the message, or select No and press [Enter]
to escape.

7. To return to the standby display, press [Esc] three times.
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Distress/Urgent Receiving Call Unit IC-303

The IC-303 releases an audible alarm when a normal priority mes-
sage and distress or urgency of navtex  is received. You can silence
the normal priority  alarm by pressing the ALARM RESET button.

For distress or urgency of navtex, you can silence the audible alarm
by pressing the [F10] key on the key board of terminal unit.

Figure 4-36 Distress/Urgent Receiving Call Unit IC-303

Display Log

The Display Log stores the particulars of the latest 50 received and
transmitted messages. When the log is full, the oldest message is de-
leted.

Displaying and printing the display log

1. Press [F6].

2. Press [4] to display the Display Log.

Figure 4-37 Sample display log

3. To scroll the Display Log screen, press the down key several times.
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4. To print the log, press and hold down [Ctrl] and press [P].
 “Now printing” appears on the screen.

To stop printing, press [Esc].

display log description

S/R: Send or Receive message
Message No.: Message no. or file name
Type: Currently, TELEX, PSTN, PSDN or SPEC (2-

digit code service).
Pri: Normal or distress
Date: Date message was received (or transmitted).
Time: Time message was received (or transmitted).
LES: ID of LES which handled the message
Station: Transmitting station name. Blank for unregistered

station or receive message.
Size: Size of message in bytes
Cond: Transmission results. Blank if receive message.

Success: Successful transmission
Fail: Failed transmission
Rejected: Message rejected by LES

Automatic printing of display log

The Display Log can be automatically printed every 24 hours.

1. Press [F8] to display the Setup menu.

2. Press [6] to display the Auto Mode Setup menu.

Figure 4-38 Auto mode setup menu

3. Press [Enter] to open the selection window of Auto Log Print.

4. Set Auto Log Print to ON.

5. Press [Enter] to close the selection window.

6. Press [Esc] twice.
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Display send message log or receive message log

You can display send message log or receive message log as follow.

1. Press [F6].

2. Press [1] (Send message log) or [2] (Receive message log).

3. Press [Esc] to escape.

EGC Messages

EGC messages are automatically received, printed and saved to the
DTE. The memory capacity for EGC message is 32k bytes. When the
memory is full, the oldest information is deleted.

Displaying and reprinting EGC messages

1. Press [F6].

2. Press [3]. The Display EGC Message screen appears.

Figure 4-39 Sample Display EGC Message screen

3. To scroll the message, use the up and down arrow keys.

4. To view next and previous messages, use the [N] and [P] keys.

5. To print the message appearing on the display, press and hold
down [Ctrl] and press [P]. To stop printing, press [Esc].

EGC messages can be automatically saved on a floppy disk. See page
4-24 for details.
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Displaying EGC closed network ID (ENID)

To join a FleetNETTM service, an MES must be registered with an
information provider. The information provider adds the MES to the
group which is to receive the service by downloading a Group Call
ID, via a LES which supports FleetNETTM broadcasts, uniquely ad-
dressed to the MES. The MES stores the ID and can accept broad-
casts from the information provider. The MES operator can not change
this stored EGC closed network IDs (ENIDs). Up to 64 ENIDs are
stored on a non-volatile memory.

The ENID stored can be accessed for downloading and deleting via
the satellite path. It is possible for an MES operator to inhibit (or
activate as required), via the DTE, selected ENIDs previously down-
loaded.

Along with the ENID, the name of the information provider is stored.
In the event that a download command is received and the ENID
storage area is full, then an ENID which has been inhibited (de-acti-
vated) by the MES operator will be written over. If none has been
inhibited, then the new download is not accepted.

Follow the procedure below to inhibit (or activate) an ENID.

1. Press [F4] to display EGC menu.

2. Press [2] to display the EGC Network ID List.

Figure 4-40 EGC network ID list
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3. Select an ENID you want inhibit (or activate).

4. Press the Space bar to inhibit (or [Enter] key to reactivate).

5. Press [Esc] to return to the standby display.

Receiving EGC distress or urgent message

When the FELCOM 12 receives a EGC distress or an urgent mes-
sage, an alarm buzzer sounds on the terminal unit and the Distress/
Urgent Receiving Unit IC-303 or the Distress Message Controller
DMC-5 when connected.

To silence the alarm buzzer, press [F10] on the terminal unit.

Note: To silence the alarm from the IC-302, also press . DO NOT
press the DISTRESS button on the IC-302 to silence the alarm;
you will transmit own ship’s distress alert.
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DATA REPORTING AND POLLING

This chapter explains data reporting settings and polling reception.

Data Reporting

Data reporting provides automatic data transmission at regular (pre-
set) intervals from your ship to your home office. The data are posi-
tion, speed, bearing and other data sent from a navigational equipment
or an interface unit.

The data transmitted from the FELCOM 12 is temporarily stored in a
data reporting file at the LES. When an operator at your home office
accesses the LES, the LES delivers the data to your home office.
Some LESs may deliver it without being accessed.

Data reporting can be initiated by setting a data report on the FELCOM
12 or receiving a polling command from your home office.

FELCOM 12 offers two types of data reporting as follows:

Data report ---------on MES signalling channel
Refer to “Setting a data report” below.

Message report --- on MES message channel
Refer to “Setting a message report” on page 5-4.

Setting a data report

1. Press [F5] to display the Position Reports menu.

Figure 5-1 Position reports menu
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2. Press [Enter] or [1] to display Data Report setting screen.
The cursor is on the Status line and “OFF” is selected.

Figure 5-2 Data report menu

3. Press [Enter] to open the selection window.

4. Select “ON” or “OFF”.

ON: Data report on
OFF: Data report off

5. Press [Enter] to close the selection window.

6. Press [ ] to advance the cursor to the Report Length line.

7. Press [Enter] to open the selection window.

8. Select “1” or “2”.

1: Position
2: Position, speed, bearing, depth
3: Spare (not used)

9. Press [Enter] to close the selection window.

10.Press [ ] to advance the cursor to the Destination line.

11. Press [Enter] to display the DNID list.

12.Select DNID.
(LES ID and Member ID are automatically selected with DNID.)

13.Press [Enter] to close the DNID list.

14.Press [ ] to advance the cursor to the Activation line.

15.Press [Enter] to open the selection window.

16.Select “Regular Interval” or “Daily”.

17.Press [Enter] to close the selection window.
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18.Press [ ].

When “Regular Interval”  is selected on step 16,

(1) Press [Enter] to open the window for interval time entry.

(2) Key in the interval time at Interval Time.

(3) Press [Enter] to close the window.

(4) Press [ ].

(5) Press [Enter] to open the window for report times entry.

(6) Key in the Report times or select “No limit”.

(7) Press [Enter] to close the window.

When “Daily”  is selected on step 16,

(1) Press [Enter] to open the window for start time entry.

(2) Key in the start time at Start Time 1.

(3) Press [Enter] to close the window.

(4) Press [ ].

(5) If necessary, key in the start time of Start Times 2-4.

19.Press [Esc] to register the above settings.

Figure 5-3 Data report menu

20.Select “Yes”.

21.Press [Enter] to close the Data Report window.
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Setting a message report

1. Press [F5] to display the Position Reports menu.

Figure 5-4 Position reports menu

2. Press [2] to display the Message Report.

Figure 5-5 Message report menu

3. Press [Enter] to open the window for PIN code entry.

4. Key in the PIN code.
PIN code (max. 8 digits) should be agreed upon with your recipi-
ent beforehand.

5. Press [Enter] to close the window.

6. Press [ ].

7. Press [Enter] to open the selection window.

8. Select “ON” or “OFF”.

ON: Message report on
OFF: Message report off

9. Press [Enter] to close the selection window.

10.Press [ ].

11. Press [Enter] to display the station list.

12.Select a station.
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13.Press [Enter] to close the station list.

14. Press [ ] to place the cursor on the LES ID line.

15.Press [Enter] to display the LES list.

16.Select LES.

17.Press [Enter] to close the LES list.

18.Press [ ].

19.Press [Enter] to open the selection window.

20.Select “Regular Interval” or “Daily”.

21.Press [Enter] to close the selection window.

22.Press [ ].

When “Regular Interval” is selected on step 20,

(1) Press [Enter] to open the window for interval time entry.

(2) Key in the interval time.

(3) Press [Enter] to close the window.

(4) Press [ ].

(5) Press [Enter] to open the window for report times entry.

(6) Key in the report times or select “No Limit”.

(7) Press [Enter] to close the window.

When “Daily” is selected on step 20,

(1) Press [Enter] to open the window for start time entry.

(2) Key in the start time.

(3) Press [Enter] to close the window.

(4) Press [ ].

(5) If necessary, key in the start time of Start Times 2-4.
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23.Press [Esc] to register the above settings.

Figure 5-6 Message Report Screen

24.Select “Yes”.

25.Press [Enter] to finish.

Polling

When the FELCOM 12 receives a polling command from your home
office, it automatically transmits data to your home office. The data
are position, speed, bearing and other data sent from a navigational
equipment or an interface unit.

A polling command from your home office can also activate data
report or message report if the corresponding setting is completed on
the FELCOM 12. If a polling command with a file name is received,
the FELCOM 12 transmits the file to your home office.

Polling command

This paragraph shows you how to make the polling command at your
home office.

There are two kinds of polling commands: one is sent on the MES
signalling channel and the other is sent on the MES message channel.

Polling command on MES signalling channel

Request a land station to make the polling command because the for-
mat vavies with land station.
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Polling command on MES message channel

To make the polling command, enter D???, hyphen, PIN code (max.
8 digits), hyphen, file name (stored in the floppy disk of the FELCOM
12), colon and text of message.

To send file data, type a hyphen and file name. If no hyphen and file
name is entered, MES automatically transmits nav data (own ship
position, course, speed, etc). For PIN Code setting refer to page 5-4.

Figure 5-7 Polling command

Polling reception

No operator intervention is required during polling reception.

The printer PP-510 prints the status of polling reception and data
transmission in response to polling request as shown below.

Figure 5-8 Sample MES signalling channel printout
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Figure 5-9 Sample MES message channel printout

DNID (Data Network Identification)

When you make a contract with an information provider, DNIDs are
downloaded from the information provider to your FELCOM12 via
an LES.

Up to 64 DNIDs can be downloaded to the FELCOM 12.

Displaying DNID

1. Press [F5] to display the Position Reports menu.

2. Press [3] to display the Data Network ID screen.
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Data Network ID

RET: Activate   SPACE: Inhibit   Ctrl+P: Print   ESC: Quit
Mark ‘*’ means activation.

No.

01
02
03
04
05
06
07
08
09
10

Act

*
*
*
*
*
*
*

DNID

00004
00004
23456
03333
03333
07777
09999

LES

101
101
101
101
101
101
101

Subaddr

000
002
002
002
000
000
000

Member

001
003
223
044
044
099
088

Text

Figure 5-10 Data network ID menu

Note:  DNID with “*” mark are available for use.

Enabling/Disabling DNID

DNID can be enabled or disabled as follows:

1. Press up/down arrow key to place the cursor on the desired DNID.

2. Press [Enter] to enable the DNID. (* mark appears.)
Press [Enter] to disable the DNID. (* mark disappears.)

Note: When a DNID is disabled “running data program (poll)”
is displayed and polling is cancelled.

3. Press [Esc] to close the window.

4. To return to the standby display, press [Esc] twice.

Note: “Disable”not permitted in FFA version.
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DISTRESS ALERT

Preparing a Distress Alert

1. Press [F8] to display the Setup menu. Note that this key has pre-
cedence over any operation.

2. Press [1] to display the Distress Message Setup screen.

Figure 6-1 Distress Alert setup screen

3. The default LES ID is 144, AOR-E, NCS. To change, press [En-
ter] to display the LES ID list. Select a suitable LES and press
[Enter].

4. Press [ ] to select Update Time. Enter the time (hours and min-
utes and date) if necessary. The time indication stays still show-
ing the last update. Current time and position are shown at the
bottom right on the screen.

5. Press [ ] to select Position.

6. Press [Enter] to open the window for position entry.

7. Enter position in latitude and longitude. Use [ ] to shift the cur--
sor from degree to minutes and co-ordinate. Enter co-ordinate with
appropriate alphabet key.

8. Press [Enter] to close the window.

9. Press [ ] to advance the cursor to the Protocol line.

10.For marine vessels Protocol should be set to Maritime.
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11. Press [ ] to select Nature. Press [Enter] to display the list. Select
appropriate nature of distress.

Undesignated Listing
Fire/Explosion Sinking
Flooding Disabled & Adrift
Collision Abandoning ship
Grounding Further assistance required

Piracy or Armed Attack

If nature of distress is not specified, “Undesignated” is auto-
matically selected.

12.Press [Enter] to close the list.

13.Press [ ] to go to the Course and/or Speed entry. Enter course
and/or speed if they are different from what appears on the screen.

14.Press [Esc]. You are now asked to update data entered.

*Current update is shown at the position display of the bottom right corner.

Figure 6-2 Distress Alert setup, requesting confirmation of
settings

15.Press [Enter] to register data you’ve just entered.

Figure 6-3 Distress Alert setup, distress alert updated
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Transmitting a Distress Alert

1. Open cover on DISTRESS button.

2.   Press the DISTRESS button 4 seconds on Distress Alert Unit IC-
302.

Note:  Within 3 seconds, the distress alert will not be tramsmitted.

     The lamp inside the button flashes quickly and an audible alarm
sounds intermittently. Four seconds later, the distress alert is trans-
mitted and light the lamp and an audible alarm sounds continu-
ously. When you receive acknowledgment of the distress alert
from an LES, the lamp flashes slowly and the audible alarm sounds
intermittently.

To silence the audible alarm, press [F10].

Figure 6-4 Distress Alert Unit IC-302

Do not press the button to silence an alarm for incoming distress
or urgent message. This will transmit a distress alert for own ship.
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Testing Distress Button

The DISTRESS button on the IC-302 may be tested without trans-
mitting the distress signal as follows:

1. Press [F7] to display the Options menu.

2. Press [6] to display the Test menu.

Figure 6-5 Test Menu

3. Press [4].

4. Press [Enter]. The Distress Alert Button Test mode screen appears.

Figure 6-6 Distress alert button mode screen

5. Open cover on DISTRESS button.

6. Press the DISTRESS button 4 seconds.

7. Confirm that the IC-302 sounds the audible alarm.

8. Close the cover on DISTRESS button.

9. Press any key to escape.
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Distress Communications

The distress alert provides the minimum distress reporting require-
ments: own vessel’s ID, speed, course, L/L position and nature of
distress. After receiving the distress alert acknowledgment and you
are not pressed for time you may send detailed information as fol-
lows:

1. Press [F1] followed by [Enter] to display the editor screen.

2. Prepare distress communication message. Figure 6-7 shows a
sample distress message.

Figure 6-7 Sample distress message

3. Press [F3].

4. Press [Enter]. The screen should look something like Figure 6-8.
The cursor is on the Priority line.

Figure 6-8 Transmit message screen

5. Press [Enter] to open the selection window.

6. Press [ ] to select “Distress”.

7. Press [Enter] to close the selection window.

8. Press [ ] to go the LES ID line.

9. Press [Enter] to open the LES list.

10.Select the LES where the distress alert was transmitted.
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11. Press [Enter] to close the LES list.

12.Press [ ] to place the cursor on TRANSMIT..

13.Press [Enter]. The display should look similar to Figure 6-9.

Figure 6-9 Transmit message screen with send start confirmation
prompt

14.Press [Enter] to transmit the distress message to the LES.

Note: Country/Ocean Code and Station ID are not required in a
distress message.
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OTHER FUNCTIONS

This chapter describes how to abort operation, scan NCS and select
EGC and NCS channels.

Aborting an Operation

You can abort transmission, receiving or scanning during operation.

1. Press [F7] to display the Options menu.

Figure 7-1 Options menu

Note: If the FELCOM 12 is set to operate as an EGC-only re-
ceiver, the menu looks like this:

Figure 7-2 Options menu, EGC-only receiver status

2. Press [3] to select Abort.

Figure 7-3 Abort screen

3. Press [Enter] to abort. (The message “Forced Clearing” replaces
either Sending, Receiving or Scanning at the bottom of the screen.)

Note: Aborting is possible in sending, receiving or scanning. If
attempted in other operating modes “Cannot abort cur-
rent process.” appears.
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Scanning NCS

The communication unit automatically tunes itself to the NCS se-
lected on the System Setup menu. You can, however, tune to another
NCS which has a stronger signal. Scanning is possible only when the
communication unit is IDLE and FELCOM 12 is set to operate as an
Inmarsat-C transceiver.

If the communication unit is not idle, “Communication unit is not
Idle now. Cannot start scan.” appears. Press any key to escape then
wait until the unit is in the idle state.

1. Press [F7] to display the Options menu.

2. Press [5] to display the Ocean Region screen.

Figure 7-4 Ocean region screen

3. The NCS you are currently tuned to appears in reverse indication.
If necessary, select another NCS.

4. Press [Enter].
If Auto is selected, FELCOM 12 scans all NCSs in turn. If a par-
ticular ocean region is selected, FELCOM 12 scans all channels
of that NCS. (NCSs will begin using multiple channels when the
third generation satellites come into use.)

Figure 7-5 NCS scan confirmation screen

5. Press [Enter] to start the scanning.

The message “Starting Scan Process. Press any key to escape.”
appears during the scanning.
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Selecting EGC Receiving Channel

EGC channel can be selected when the DTE is set to operate as an
EGC-only receiver. This procedure is shown for reference; currently
there is only one EGC channel per NCS.

1. Press [F8] to display the Setup menu.

2. Press [9] to display the Configuration menu.

3. Press [3]. The EGC channel which the EGC receiver is currently
tuned to appears on the display in reverse indication.

Figure 7-6 EGC channel list screen

4. Select desired channel.

5. Press [Enter] to start the tuning.

6. Press [Esc] to close the Update screen.

7. Press [Enter] to select “Yes”.
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Selecting NCS Channel

NCS channel can be selected as shown in the procedure below. Cur-
rently, each satellite transmits one global beam. In the future, the sat-
ellites will transmit multiple spot beams, namely, the NCS will have
multiple channels.

1. Press [F7] to display the Options menu.

2. Press [4] to display the Select NCS menu. The NCS Channel
List appears.
NCS channels programmed at page 2-16 appear on the list.

Figure 7-7 NCS channel list

3. Select NCS channel.

4. Press [Enter].

5. Press [Esc] to close the Update screen.

6. Press [Enter] to select “Yes”.
The unit tunes to the channel selected.
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MAINTENANCE

This chapter provides the information necessary for the maintenance
and checking of the FELCOM 12.

Safety Information



8-2

General Checking and Maintenance

Turn off the power before conducting any maintenance procedures
other than the cleaning of the terminal unit and communication unit.

Cleaning the terminal unit and communication
unit

These units can be cleaned with a soft, dry cloth. DO NOT use chemi-
cal cleaners. They may remove paint and markings.

Checking connectors and earth terminal

The connectors and earth terminal on the rear panel of the communi-
cation unit and on the bottom panel of the terminal unit should be
checked periodically for tightness. If the earth terminal has rusted,
clean it.

Floppy disk drive head

The floppy disk is coated with a magnetic material which stores in-
formation entered into the disk. If this material is damaged by for-
eign material adhering to the disk drive head it may not be possible to
read from or write to the disk. Clean the head regularly with a clean-
ing floppy disk to prevent loss of data.

When the power can’t be turned on (power lamp
does not light)

3) and 4) are for service technicians.

1) Check the power cable connector on both the rear panel of the
terminal unit and communication unit for tightness. Check if the
ship’s mains switchboard is turned on.

2) On the terminal unit, check the breaker on the rear panel. If it has
tripped it will be protruding several millimeters. Reset it if neces-
sary.

3) On the rear panel of the terminal unit, disconnect the power cable.
Connect a multimeter to the power cable connector and confirm
21.6 and 31.2 V. (pin #1: positive, pin #2: negative)

4) On the rear panel of the communication unit, disconnect the power
cable. Connect a multimeter to the power cable connector and
confirm 21.6 and 31.2 V. (pin #1 and #2: positive, pin #3 and #4:
negative)
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Self Tests

The communication unit and the terminal unit are equipped with self
tests which check them for proper operation.

Self test at power application (communication
unit)

The communication unit performs the following tests when it is turned
on:

a) ROM sum test
b) RAM read and write test
c) DP RAM read and write test
d) EEPROM sum test
e) VITERBI decoder test

If the unit finds no fault it goes into normal operation.

Testing the communication unit through the
keyboard

This test can only be initiated from the main DTE. The communica-
tion unit must be idle.

1. Press [F7] to display the Options menu.

2. Press [6] to display the Test menu.

3. Press [3]. The Communication Unit (self test) screen appears.

Figure 8-1 Communication unit screen

4. Press [Enter] to start the test.

The message “Now Communication Unit-testing” appears in
blinking reverse video during testing.
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5. When the test is completed the screen shows the results of the
test.

Figure 8-2 Sample communication unit self test results

Either “OK” or “NG” (No Good) appears next to each ROM and
RAM tested. NG display releases the audible alarm. For defec-
tive ROM, RAM, DP-RAM, EEPROM or VITERBI replace the
CPU Board. For GPS, NG appears when there is no GPS board or
it is faulty.

6. Press any key to finish the communication unit test.

Performance Verification (PV) Test

After the FELCOM 12 is installed, the installing technician usually
confirms that the unit is functioning properly and is logged in with
the Inamarsat C system by conducting the PV test.

The PV test consists of the message reception test, message transmis-
sion test and distress alert test.

The results of the test appear on the PV test result display.

Note that the test cannot be conducted from a 2nd DTE. Note also
that the test can be initiated by a LES.

PV test sequence

1. Select PV Test on the Test menu.

2. The NCS acknowledges request for testing.

3. The MES, upon receiving acknowledgment from NCS, goes into
pending state.

4. NCS will select a (not busy) LES to perform the test.

5. The LES transmits a test message to the MES.

6. MES transmits a test message to the designated LES.

7. LES receives test message.
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8. The MES automatically transmits the distress alert test within two
minutes after completion of step 8.

9. When the distress alert test is finished the results of the test are
sent to MES.

The entire PV test can be conducted automatically (taking about
15 minutes in total).

PV test procedure

1. Confirm that the communication unit is in idle condition and
logged in.

2. Press [F7] to display the Options menu.

3. Press [6] to display the Test menu.

4. Press [1] to select PV Test.

Figure 8-3 PV test screen

Note: If the communication unit is not idle when the test is initi-
ated the screen displays “MES is not idle now. Cannot start
PV Test.” And if not logged in, “Cannot start PV Test. (not
Logged-in)” appears.

5. Press [Enter] to transmit the PV test request to NCS.

Figure 8-4 PV test screen

6. Press [Esc] to return to the standby display.

7. The screen displays “Current State: Idle (pending!)” when the
acknowledge signal is received from the NCS.

8. When testing begins the screen displays “Current State: TEST-
ING”.

9. Transmit a message to the LES. The LES, after acknowledging
receipt of your message, transmits a message to you.
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10.Though a prompt asks you to test distress alert, do not press any
key. The alert test is automatically conducted two minutes later.

11. When testing is completed the indication TESTING is replaced
by IDLE.

12.The test results appear on the PV Test Result screen. (The next
section shows how to interpret the results.)

Results of PV test

1. At the standby display, press [F7] to display the Options menu.

2. Press [6] to display the Test menu.

Figure 8-5 Test menu

3. Press [2] to display the results of the PV test.

Figure 8-6 Sample PV test results

Note: If the communication unit is off or malfunctioning, “DCE
error: No response from DCE!!” appears. Check the con-
nection between the communication unit and the terminal
unit.

4. To escape, press any key. The standby display appears.

Interpreting the PV tests results display

Test Date & Time: Date and time of test

Attempts: Number of times the PV test was con-
ducted.
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BBER: Bulletin Board Error Rate (%). Pass ap-
pears for no error.

Shore-to-Ship Attempts: Number of tests initiated by LES.

Ship-to-Shore Attempts: Number of tests initiated by MES.

Distress Alert: “Pass (Test OK)” appears for successful
testing.

Signal Strength: “Pass” appears if signal strength is greater
than standard level.

Overall Result: “Pass” appears for satisfactory comple-
tion of test.

System Status Monitor

The system status monitor, which is always displayed, provides date,
time, equipment status and navigation data on one screen.

Figure 8-7 System status monitor display
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Interpreting the system status monitor

Date: Current date

Time: Current time

Position: Vessel’s position (either manual entry or au-
tomatic input by navigation aid)

Waypoint: Destination

Course: Heading

Speed: Ship’s speed

Current NCS: NCS your vessel is logged in with

Current Channel: Channel in use

Current TDM: Channel TDM

MES Status: Operational status of MES

GPS Status: Receiving signal status from GPS receiver.
CST: Cold Start
ACK: Acquired; Almanac data acquired
IMP: Impossible; cannot receive GPS signal
INT: Interrupted; object interfering reception

of GPS signal
ALM: Receiving the almanac
2D, 3D: Position-fixing method by 2 or 3 di-

mension

Note: The above status indication depends on the GPS
receiver connected.

DCE memory: Memory remaining in communication unit

BBER: Bulletin Board Error Rate (%)

C/N: Check of circuit status with LES, receiving
circuit in antenna unit, RF CON Board and
CPU Board (DEMOD section). OK appears
for figure greater than 31.

Send Level: TX level check. At transmission, OK appear
for more than 123. At reception OK appears
for figure less than 32.

RX IF AGC Level: Check the receiving circuit of the antenna unit
and the RF CON Board in the communica-
tion unit. OK appears for figure greater than
80.
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REF Offset Freq: Operating normally.  If it does not light check
RX Synthesizer or REF OSC in the RF CON
Board. OK appears for figure less than 150.

Synthe 1st Local: Check of RF CON Board.

RX 2nd Local: Check of RF CON Board 2nd local oscilla-
tor.

Antenna Power Supply:
NG appears for discontinuity or short in cable.

Temperature*: Water temperature

Water Current*

   Direction: Tidal current direction

   Speed: Tidal current speed

Depth*: Depth of water

Note: * requires data from the navigation device.

Replacing Internal Battery

A lithium battery in the communication unit is used to backup system
settings. The life of this battery is about five years, however actual
life depends on usage when the battery is dead the communication
unit automatically reverts to default system settings. Contact you
dealer to request replacement of the battery.

Name: BTT(L1)
Code No.: 000-103-769
Type: CR1/2 8.L-F



SP-1

SPECIFICATIONS

Transmitting Frequency 1626.5 to 1646.5 MHz

Receiving Frequency 1530.0 to 1545.0 MHz

Antenna Omnidirectional

G/T Better than -23 dB/K (elevation angle 5˚)

EIRP 12 to 16 dBW (elevation angle 5˚)

Modulation BPSK

Modulation Rate 1200 sps

Coding Convolutional coding with coding rate
1/2 and constraint length 7

Decoding Viterbi decoder

Transmission Speed 600 bps

Internal GPS Receiver (option) Eight discrete channels, all-in-view
Approx. 50 m, 95% of the time, Horizontal dilution of
position (HDOP)<4
All GPS receivers are subject to degradation of position
and velocity accuracies under the U.S. Department of
Defense.

Navigation Equipment Interface Internal GPS Board (option): NMEA0183

Operating Environment Above deck equipment

Temperature: -35˚C to +55˚C
Relative humidity: 95% (at 40˚C)

Below deck equipment

Temperature: -20˚C to +55˚C
Relative humidity: 95% (at 40˚C)

Ship’s Mains Communication unit, Terminal unit and Printer: 24VDC
100/110/120/200/220/240 VAC by optional AC-DC
Power Supply Unit PR-300]

Power Consumption IC-112 & IC-212: Receiving 25W, Transmitting 120W
IB-581: 18W
PP-510: 36 W MAX
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Color            Antenna unit: N9.5
Antenna unit base: 2.5PB3.5/10
Communication unit: N3.0
Terminal unit: Cover: 2.5GY5/1.5

     Panel: N3.0
Distress alert unit: 2.5GY5/1.5
Received call unit: 2.5GY5/1.5

Waterproofing: Antenna unit: IEC529 IPX6
Communication unit: IEC529 IPX2
Terminal unit: IEC529 IPX0
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APPENDIX

International Telex/Telephone Country Code List
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International Telex Abbreviations

Abbreviation Meaning

ADV Advise
ACK Acknowledge
AGN Again

BI (GS) Good bye
BK I cut off.

CFN Confirm
COL Collation
CRV How do you receive?
DER Out of order
DWN Down
EEE Error
FM From
GA Go ahead.

MNS Minutes
MOM Wait (Waiting)
MUTI Mutilated
NA Correspondence to this subscriber is not admitted.
NC No circuits

NCH Snbscriber’s number has been changed.
NP The called party is not or no longer is a subscriber.
NR Indicate your call number.

OCC Subscriber is engaged.
OK Agreed.

P (or 0) Stop your transmission.
PLS (PSE) Please

PPR Paper
P (RCD) Received

RAP I will call you again.
RD Reed
RE Referring to
RPT Repeat
SRY Sorry
SVP Please
TAX What is the charge?

TEST MSG Please send a test message?
THRU You are in communication with telex position

TKS (TNX) Thanks
TLX Telex
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Glossary of Acronyms

Acronym Meaning

AOR-E Atlantic Ocean Region-East
AOR-W Atlantic Ocean Region-West

BB Bulletin Board
BBER Bulletin Board Error Rate
BPSK Binary Phase Shift Keying

BS Back Space
C/N0 Carrier to Noise Power Spectral Density
CNID Close Network ID
CPU Central Processing Unit

CSDN Circuit Switched Data Network
DCE Data Circuit Terminating Equipment

DP-RAM Dual-Port Random Access Memory
DTE Data Terminal Equipment
EGC Enhanced Group Call
EIRP Equivalent Isotopically Radiated Power
FD Floppy Disk

GPS Global Positioning System
G/T Gain to Noise Temperature Ratio
HPA High Power Amplifier
IA5 International Alphabet No.5
ID Identity

IMO International Maritime Organization
INMARSAT International Mobile Satellite Organization

IOR Indian Ocean Region
ISDN Integrated Services Digital Network
ITA2 No.2 International Telegraphy Alphabet
ITU International Telecommunications Union
LES Land Earth Station
LNA Low Noise Amplifier
MES Mobile Earth Station
MSI Maritime Safety Information

NAVAREA Navigational Area
NAVTEX MF Navigational Broadcast Service

NCS Network Coordination Station
NMEA National Maritime Electronics Association
OCC Operation Control Center
PEP Packet Error Probability
POR Pacific Ocean Region

PSDN Packet Switched Data Network
PSTN Public Switched Telephone Network
PVT Performance Verification Test
RAM Random Access Memory
RCC Rescue Coordination Center
ROM Read Only Memory
SCC Satellite Control Center
SFU Store and Forward Unit

SOLAS Safety of Life at Sea
TDM Time Division Multiplex

TDMA Time Division Multiple Access
UTC Coordinated Universal Time
WMO World Meteorological Organization
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International Telegraphy Alphabet
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Error Messages and Alerts

A file by that name already exists on FD.
This message appears when you attempt
to copy a file from the internal memory to
a floppy disk and a file by that name al-
ready exists on the disk.

Cannot use this LES. Please check network configuration.
You input an invalid LES ID.

Cannot abort current process.
The terminal unit displays this message if
you try to stop the DCE in operating con-
dition other than sending, receiving or
scanning.

Cannot activate distress alert test.
Distress alert testing cannot be done with-
out permission from LES.

Cannot enter this message to sending Queue.
This message appears when a message is
sent to the message queue and it is full (two
messages maximum).

Cannot start PV Test. (not Logged-in)
You cannot start PV testing without first
logging in.

Cannot start to send. (EGC Receiver)
Transmission is not possible when the
FELCOM 12 operates as a EGC-only re-
ceiver.

Cannot start to send. (not Logged-in)
A message cannot be transmitted without
first logging in.

Close a file in use to make a new file.
The working areas are full (capacity: two
files). Close a file to load a file to a work-
ing area.

Communication Unit is not Idle now. Cannot start login.
Cannot login when the communication
unit is not idle.

Communication unit is not Idle now. Cannot start scan.
This message appears when the FELCOM
12 operates as a EGC-only receiver and
scanning is initiated when the communi-
cation unit is not idle. Wait until the unit is
idle before starting scanning.

Communication Unit is not Idle now. Cannot start logout.
Cannot logout when communication unit
is not idle.
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Current State : Idle (pending!)
This message appears when a LES affir-
matively acknowledges your request for
PV testing.

Current State : Testing You will see this display during PV test-
ing.

DCE Error : No response from DCE!!
This message appears when you try to dis-
play the PV test results and there was no
response from the communication unit
because it is off or its interconnection cable
is disconnected or damaged.

Distress Message updated. Press any key.
This message appears after you have cor-
rectly updated the distress message.

Distress Alert Acknowledgment Received
This alert will appear when the LES trans-
mits the distress acknowledge signal to
your vessel.

FD not inserted in drive.
You need to insert a floppy disk into the
drive.

FD not inserted in drive. Press any key to escape.
This message appears if you attempt to
format a disk and there is no disk in the
drive.

File by that name already exists. OK to overwrite?
This alert asks you if it is alright to write
over an existing file name.

Formatting Completed. This alert appears upon completion of
floppy disk formatting.

Input Error : Message File
You have manually input an invalid file
name.

Internal GPS unit failure.
This message appears when the internal
installed GPS unit is not working or is
faulty. When the navigation port is not set
to “INT”, this message does not appears.

Invalid Frequency Code.
This message appears when a wrong fre-
quency code is entered in the EGC Chan-
nel List or NCS Channel List.

Invalid NCS ID Code. This alert appears when a wrong NCS ID
code is entered.

Loading Appears during loading of a file to a work-
ing area.
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Message file is too big (partial transmission possible).
The size of the file you want to send is
larger than 31,500 bytes. (The file can be
sent, but only the first 32,000 bytes of in-
formation will be received.)

Message is entered in sending buffer.
Before a message is transmitted it is sent
to the message queue. This alert informs
you the message has been accepted by the
message queue.

Message Send failed. Could no send message because of satel-
lite malfunction, etc.

Message Send pending.All circuits occupied at LES.

Message Send rejected. This alert appears when the LES rejects a
message because of unpaid subscriber’s
fee or other reasons.

No response from communication unit!
This message will appear if the communi-
cation unit is turned off or its interconnec-
tion cable is disconnected or damaged.

Now Self-testing Terminal. (cannot abort)
Appears during testing of terminal unit.

Now printing Appears during printing.

Now Formatting Appears during formatting of floppy disk.

OK to delete file? This alert verifies if it is alright to delete a
file.

OK to format FD? This alert verifies if it is alright to format
a floppy disk.

Printer error!! The printer is off or malfunctioning.

Request started This message appears when requesting
delivery status of a message.

SAVING You will see this message when saving a
file.

SES is not idle now. Cannot start PV Test.
This message means you will have to wait
until the communication unit is idle to start
the PV test.

Starting Scan Process Press any key to escape.
This prompt appears before scanning NCS.

Update error! Retry again. Press RET to update end.
This message appears if the distress alert
message was updated incorrectly.
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LES IDs List

LES menu AOR West AOR East IOR POR

  Perth 322 222

  Goonhilly 002 102 302

  NETELY/BY/TELEN 202

  Aussaquel 121 321

  Burum 022

  Blaavand 131

  Eik/Telenor 004 104 304

  Sentosa 328 210

  Tangua 014 114

  Odessa 107 307

  Maadi 103

  Arvi 306

  Umm al Aish 106

  Fucino 105 335

  Thermopylae 120 305

  Jeddah 315

  Yamaguchi 003 103 303 203

  Santa Paula 201

  Sintra 118

  Southbury 001 101

  Ata 110 310

  Kumsan 308 208

  Raisting 115 333

  Beijing 311 211

  Psary 116 316

  Boumehen 314

  Nonthaburi 319

  Station 12 012 112 312 212

  Station 12/Telstra 122
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